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About Medicare Remit Easy Print 
Medicare Remit Easy Print enables you to print Medicare Part B and DME MAC HIPAA 
835v5010 files in a format that is similar to the Electronic Remittance Advice (ERAs).You 
can use Medicare Remit Easy Print to: 

• view MREP Remittance Advices (see page 56) 

• search MREP Remittance Advices (see page 81) 

• print MREP Remittance Advices (see page 78) 

• print reports about MREP Remittance Advices (see page 204) 

You can install Medicare Remit Easy Print on a PC or on a network (see Pre-Installation 
Checklist for Installation on a PC). 

For general information about remittances, see https://www.cms.gov/Outreach-and-Education/Medicare-
Learning-Network-MLN/MLNProducts/Downloads/Remit-Advice-Overview-Fact-Sheet-ICN908325.pdf 

Informational 
• MREP accepts remittances in the X12 835V5010A1 and X12 835V4010A1 formats. MREP no longer 

accepts remittances in the X12 835V5010 format. Since the X12 835V5010 format was only used 
during the transition period from X12 835V4010A1 and was never used in production, the user guide 
refers to the X12 835V5010A1 format as X12 835V5010. 

• MREP Version 4.5 includes the CARC and RARC lists published by the WPC (Washington 
Publishing Company) as of 1/1/2016 (CARC) and 11/1/15 (RARC) and Code Combination Business 
Scenarios published by the CAQH/CORE in February 2016 (spreadsheet v.3.2.2). Future lists will be 
made available individually and can be imported into MREP to keep the codes current. For more 
information, see How to View the CARC and RARC Codes.  

What’s New 
• A new search criteria option was added to the Search tab. You can now search a selected 

remittance for a specific Claim Adjustment Reason Code (CARC).   
o A search using a CARC as the criterion produces results that are an exact match to the 

value you entered. The Search Type options, including Begins With and Contains, are 
not selectable.   

o CARCs can be found at the claim header level or the service line level and all valid 
results appear in the Search tab results grid. 

 

https://www.cms.gov/Outreach-and-Education/Medicare-Learning-Network-MLN/MLNProducts/Downloads/Remit-Advice-Overview-Fact-Sheet-ICN908325.pdf
https://www.cms.gov/Outreach-and-Education/Medicare-Learning-Network-MLN/MLNProducts/Downloads/Remit-Advice-Overview-Fact-Sheet-ICN908325.pdf
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o The adjustable results grid displays all of the fields currently shown for other service 

line level searches as well as new columns for GRPCD, CARC, and CARC Amt. 
These new fields do not appear when you use other search criteria. 

o When results appear for a claim header level CARC, fields for details that don’t apply 
to the claim level are blank (such as Product/Service ID, Service Date(s), POS, 
Rendering Prov#/NPI, and Line #). 

• When you print selected claims in the Claim Detail view with the Glossary option selected, 
the Glossary may not begin at the top of a new page as it used to. The Glossary begins after 
the end of the claim data if there is enough space on the page for the heading and at least the 
first glossary item. If there isn’t enough room, the Glossary begins at the top of a new page. 
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Differences between MREP Remittance Advices and Shared 
System ERAs 
It is important to understand that the Medicare Remit Easy Print Remittance Advice is a representation of the 
HIPAA 835v4010A1 or the HIPAA 835v5010 transaction data. Although CMS attempted to make the 
Medicare Remit Easy Print generated Remittance Advice very similar to the Shared System Maintainer 
generated SPR (received by mail), the printed information and data content at times may differ. So, the two can 
be compared as long as there is an understanding of why they differ. 

For example, the HIPAA 835v5010 transaction data contains reversal (mother) claim information and, in turn, 
the Medicare Remit Easy Print Remittance Advice displays this information and uses it in the calculation of 
the entire remittance total. The CMS systems that create the file for the SPR received by mail have the ability 
to net the claim information for adjustments prior to generating the SPR. The HIPAA 5010 transaction has no 
facility to convey the information to allow MREP to net the claim information for adjustments prior to 
generating the Medicare Remit Easy Print Remittance Advice and, therefore, must do a complete back-out of 
the original claim and build a new adjusted claim with the modified information. 

Item Medicare Remit Easy Print Shared System 

Adjustments You must calculate the net. 

Claim Example #1 
Original Claim 000000000001000 
Provider Paid $100.00 
Adjustment Claim 000000000001001  
Provider Paid $80.00 
Provider Paid $20.00 (overpayment) 

Claim Example #2 
Original Claim 000000000002000  
Provider Paid $100.00 
Adjustment Claim 000000000002001  
Provider Paid $150.00 
Provider Paid $50.00 (underpayment) 

The net was calculated for you. 

Claim Example #1 
Adjustment Claim 000000000001001 
Provider Paid $20.00 

Claim Example #2 
Adjustment Claim 000000000002001 
Provider Paid $50.00 

PREV PD Always blank Calculated for you 

General Messages 
for Suppliers/ 
Providers (Provider 
Bulletin Board) 

Not shown Shown 



Medicare Remit Easy Print  About This Guide 

© 2016 Sponsored by the Centers for Medicare & Medicaid Services (CMS)  
under contract HHSM-500-2007-00021I/HHSM-500-T0008 – VMS Maintenance.  This document contains confidential and 

 proprietary information, which shall not be used, disclosed, or reproduced without the express written consent of CMS. 

7 

About This Guide 
All personal health information has been replaced with fictitious information.  

To use this guide, you need to have a working knowledge of Microsoft Windows.  

For example, you need to know how to: 

 access your desktop, 

 use the Start menu, and 

 use Microsoft Windows Explorer. 

You also need to know common Microsoft Windows terminology. For example, Start > 
Programs refers to the Programs option on the Start menu. 

Need Assistance? 
If you need assistance, please contact: 
Email Your Medicare contractor 
Phone Your Medicare contractor 

PC Requirements  
Recommended Speed: 2.0 gigahertz (GHz) or faster 
RAM (Random Access Memory) 256 megabytes (Mb) or above 
Hard Disk Space 1 gigabyte (GB) 
Display 1024x768 High Color (16-bit) 
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Operating System Requirements 
Recommended: Windows 7 
 
.NET Framework:   2.0 SP2 

This application uses Visual Basic.Net, a Microsoft compatible language and, 
like many applications that require an MS Windows platform, MREP requires 
a .NET framework. More than likely one or more.NET frameworks were pre-
installed on your Windows operating system or Windows Update downloaded 
a newer version on your PC. You must have .NET framework version 2.0 SP2 
on each PC using the MREP Application. 

Note: .NET frameworks 3.0, 3.5, and 4.0 include the 2.0 SP2 framework so 
if one of these frameworks is present, .NET 2.0 SP2 does not need 
to be installed separately. Windows 8 users may need to install or 
enable the .NET 3.5 framework 3.5 on each PC that uses MREP. 

If you do not have the necessary framework installed, you may receive a 
message stating that this version of the framework is required during the 
installation process and prompting you to install it. 

 
By clicking Yes—and if you have access to the Internet—you are redirected 
to the Microsoft web site to download the .NET framework 2.0 SP. Download 
NetFx20SP2_x86.exe for 32-bit systems or NetFx20SP2_64.exe for 64-bit 
systems. We do not recommend that you download a beta version of the 
.NET framework if you are presented with this option on the Microsoft web 
site.  

Outside of the application installation process, you may also visit the link to 
Microsoft .NET Framework Version 2.0 Service Pack 2 at the Microsoft 
website to transport directly to the location on the Microsoft web site to 
download the 2.0 SP2 .NET framework version. 

If you want to learn more about the 2.0 SP2 .NET Framework version and/or 
determine if you need to install this version, you may visit  
.Net Framework Developer Center at the Microsoft website. 
Please follow the directions within the web site when using this link. 
If you do not have access to the Internet and you receive a message to 
update your .NET framework, you have to obtain a copy of the .NET 
framework from Microsoft. The Medicare Remit Easy Print application does 
not work without the appropriate .NET framework installed on each machine 
accessing the application. 

  

http://www.microsoft.com/en-us/download/details.aspx?id=1639
http://msdn.microsoft.com/en-us/netframework/default.aspx
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Decompression Application: To download the Medicare Remit Easy 
Print program from your Medicare contractor’s web site, you must have the 
following: 

• Access to the Internet. 

• 7-Zip, WinZip, or a compatible decompression application to extract files. If 
you do not have a decompression application, you can go to a number of web 
sites to acquire one (For example: http://www.winzip.com/downwzeval.htm). 
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How Does Medicare Remit Easy Print Get Medicare 
Remittance Info? 

You have to import Medicare remittance information into Medicare Remit Easy Print. For 
more information about importing, see Importing HIPAA 835 files. 

 The files that you import are the ANSI files. For more information about the format of these 
files, see Appendix A: MREP RA/HIPAA 835v5010 Segment Field Crosswalk. 

 When Medicare Remit Easy Print reformats and saves a copy of an HIPAA 835 file, it is 
called the Import file. For information about how EasyPrint names the Import files, see Import 
File Name Format.  

Medicare Remit Easy Print keeps all of the Import files in the Import folder in the Medicare 
Remit EasyPrint directory. 

Information for Administrators 
Medicare Remit Easy Print can be installed on a PC or network.  

To install MREP: 
• on a PC, see PC Installations 
• on a network, see Installing Medicare Remit Easy Print on a Network 

Network Installations 
Medicare Remit Easy Print Directory 

There must be sufficient space on the network to save the Import file(s). 

The Medicare Remit Easy Print software takes about 4000 KB. 

Users must have Read/Write access to the directory where the software is installed because the 
software creates files and saves them using the user’s security privileges to the directory. 

Medicare Remit Easy Print Access 

If you need to make Medicare Remit Easy Print available to all users who log on, indicate this 
during the installation procedure. 

Group Code MSI file 

When installing the application on a network, each PC that accesses the application must have 
installed the Group Code MSI file. 
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Pre-Installation Checklist for Installation on a Network 
Before you install Medicare Remit Easy Print, you need to complete these steps: 

Step Description Completed 
 

1 Check that the network, all PCs, and printers meet all requirements. No data 

2 Find out where to save the Medicare Remit Easy Print installation software 
on your C:\ drive or Desktop.  

The file name is: Medicare Remit Easy Print.msi 
Write the location here: 

No data 

3 Find out where to save the Medicare Remit Easy Print Group Code .msi file 
on your C:\ drive or Desktop: 

The file name is: GroupCode.msi 
Write the location here: 
Note: The GroupCode.msi must be installed on all PCs executing 

EasyPrint from a network location or any PCs that access network 
locations from within the application. 
When installed on a network drive, only the EasyPrint shortcut and 
the GroupCode.msi package need to be installed on PCs executing 
the application. There is no need to install the application on each 
individual PC.  
To ensure each client PC can access the application: from the client 
PC, navigate to the network location where Medicare Remit Easy 
Print is installed, right click on the EasyPrint.exe file, and select 
“create shortcut”. This shortcut can then be copied to the desktop of 
the client PC. This step is necessary in the event the network drive 
mapping is different on the client PC. 

No data 

4 Create a folder called HIPAA 835 files and make sure that all users know the 
location.  
This folder must have adequate security for PHI. 
Write the location for the HIPAA 835 files here: 

No data 

5 Create a directory on the server for the Medicare Remit Easy Print 
installation.  
This directory must have adequate security for PHI. 

No data 
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Installing Medicare Remit Easy Print on a Network 
When you install Medicare Remit Easy Print on a network: 

 install Medicare Remit Easy Print on the network 

 install the Medicare Remit Easy Print Group Code on every PC accessing the 
application 

Before You Install Medicare Remit Easy Print on a Network 
Before you install Medicare Remit Easy Print: 

 complete the Pre-Installation Checklist for Installation on a Network 

How to Install Medicare Remit Easy Print on the Network 

Important! 
If this download cannot get past your network firewall, please contact your Medicare contractor. 

Download Instructions 

From the CMS website: https://www.cms.gov/Research-Statistics-Data-and-Systems/CMS-
Information-Technology/AccesstoDataApplication/MedicareRemitEasyPrint.html: 

1. Select the Medicare Remit Easy Print link. 

2. Click the Medicare Remit Easy Print zip file. Depending on your browser, the file saves to 
your Downloads folder or you can save the file to the location you noted on the Pre-
Installation Checklist for Installation on a Network. 

 
3. Double click the .zip file. 

https://www.cms.gov/Research-Statistics-Data-and-Systems/CMS-Information-Technology/AccesstoDataApplication/MedicareRemitEasyPrint.html
https://www.cms.gov/Research-Statistics-Data-and-Systems/CMS-Information-Technology/AccesstoDataApplication/MedicareRemitEasyPrint.html
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.  

Installation Instructions 

1. Make sure you know the location of the Medicare Remit Easy Print.msi file (Step 2 of the 
Pre-Installation Checklist for Installation on a Network.) 

2. Open Microsoft Windows Explorer and find the Medicare Remit Easy Print.msi file. 

3. Double-click the Medicare Remit Easy Print.msi file: 

 
4. The Medicare Remit Easy Print Setup Wizard opens. 
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5. Click Next. 

The Select Installation Folder window opens. 

 

6. Click Browse to find the network location for the install. The applications and associated 
files will download to that location.  

7. On the following line, write the location where you are saving the application and where 
all of the associated folders and files are to be saved: 

________________________________________________________ 

Note: Do not install Easy Print in the C:\Program Files directory. 

8. Select Everyone and click Next. 

T \E  P i t Fil \ 
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The Confirm Installation window opens. 

9. Click Next. 

When the installation finishes1, the Installation Complete window opens.2 

 

10. Click Close. 

                                                 
1 Important! 
You must install the Medicare Remit Easy Print Group Codes on each PC. 
 
2 Best Practice: 
Make the shortcut to the Medicare Remit Easy Print executable available to all users. 
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11. Complete the Medicare Easy Print Group Code installation on each PC. See Installing the 
Medicare Remit Easy Print Group Code on a PC for more information. 

What Happens During the Installation Process? 

The following items are created and placed in the directory you designated under the Medicare 
Remit Easy Print folder in Step 6 of the Installation Instructions: 

 EasyPrint.exe 

 Easy Print icon - shortcut 

 Import folder – location of active converted HIPAA 835 files 

 Archive folder – location of inactive converted HIPAA 835 files. Inactive files are 
files not currently viewed in the application. 

 Native 835 folder – default location from which to import 835 files 

 Report Export folder - where exported Report files are stored 

 Resource folder - internal folder to application 

Installing the Medicare Remit Easy Print Group Code on a PC 
After you install the Medicare Remit Easy Print application on the network, you must install the 
GroupCode.msi file on every PC that needs to access the application. 

How to Install the Medicare Remit Easy Print Group Code  
1. Make sure you know the location of the Medicare Remit Easy Print Group Code file (Step 

3 of the Pre-Installation Checklist for Installation on a PC. 

2. Open Microsoft Windows Explorer and find the Medicare Remit Easy Print Group 
Code.msi file. 

3. Double-click the Medicare Remit Easy Print Group Code.msi file. 

  
The installation completes without opening any windows or displaying any messages. 

How to Know that the Medicare Remit Easy Print Group Code Install 
Completed Successfully 

If the installation DID complete successfully, the PC user can open Medicare Remit Easy 
Print. 

If the installation DID NOT complete successfully, the PC user cannot open Medicare Remit 
Easy Print and sees this unhandled exception dialog box.3 

                                                 
3 Hint: 
If you see this error message on the PC, you need to install the Medicare Remit Easy Print Group Code. 
You need a minimum screen resolution of 1024 X 768. 
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Click OK and install the Medicare Remit Easy Print Group Code again. 
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PC Installations 
HIPAA 835 File Location4 

Users must know the location from which to download the HIPAA 835 file they receive from 
their Medicare contractor. 

Medicare Remit Easy Print Directory 

There must be sufficient space on the PC for Medicare Remit Easy Print to save the Import 
file(s).  

The Medicare Remit Easy Print software takes about 4000 KB. The size of the Import file(s) is 
dependent upon the number of claims found in the HIPAA 835 file. 

Medicare Remit Easy Print Access 

 
The default for installing Medicare Remit Easy Print is to have it be accessible only to a single 
user on a PC. 

Getting Started 
To get started: 

1. Complete the Pre-Installation Checklist for Installation on a PC. 
 

2. Install Medicare Remit Easy Print on your PC (see page 19). 

                                                 
4 Best Practice: Create a folder called HIPAA 835 files to store your 835 files, and make sure that all users know the 
location. 
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Pre-Installation Checklist for Installation on a PC 
Before you install Medicare Remit Easy Print, you need to complete these steps: 

Step Description Completed 
 

1 Check to be sure that your PC and printer meet all requirements. No Data 

2 Find out where to save the Medicare Remit Easy Print install file.  
The file name is: Medicare Remit Easy Print.msi 
Write the location here:  __________________________________________ 

No data 

3 Find out where to save the HIPAA 835 files. 
Write the location here: __________________________________________ 

No data 

4 The default installation location is C:\Medicare Remit EasyPrint. If you want 
to install the application in another location, create a directory on the PC for 
the Medicare Remit EasyPrint installation. 
This directory must have adequate security for PHI. 
Note: Do not install Easy Print into the C:\Program Files directory. 

No data 
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Installing Medicare Remit Easy Print 

Before You Install Medicare Remit Easy Print 
Before you install Medicare Remit Easy Print: 

Complete the Pre-Installation Checklist for Installation on a PC. 

How to Install Medicare Remit Easy Print on Your PC 
Download Instructions5 

From the CMS website: https://www.cms.gov/Research-Statistics-Data-and-Systems/CMS-
Information-Technology/AccesstoDataApplication/MedicareRemitEasyPrint.html: 

1. Select the Medicare Remit Easy Print link. 

2. Click the Medicare Remit Easy Print zip file. Depending on your browser, the file saves to 
your Downloads folder or you can save the file to the location you noted on the Pre-
Installation Checklist for Installation on a PC. 

 
3. Double click the .zip file. 

.  

                                                 
5 Important! 
If this download cannot get past your PC security settings, please contact your Medicare carrier. 

https://www.cms.gov/Research-Statistics-Data-and-Systems/CMS-Information-Technology/AccesstoDataApplication/MedicareRemitEasyPrint.html
https://www.cms.gov/Research-Statistics-Data-and-Systems/CMS-Information-Technology/AccesstoDataApplication/MedicareRemitEasyPrint.html
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Installation Instructions 

4. Make sure you know the location of the Medicare Remit Easy Print.msi file (Step 2 of the 
Pre-Installation Checklist for Installation on a PC) 

5. Open Microsoft Windows Explorer and find the Medicare Remit Easy Print.msi file. 

6. Double-click the Medicare Remit Easy Print.msi file: 

 
7. The Medicare Remit Easy Print Setup Wizard opens. 

 

8. Click Next. 
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The Select Installation Folder window opens. 

 

9. If you want to accept the default installation location, click Next. To install in another 
location, click Browse to find the location for the install. The applications are downloaded 
to the location you selected.  

10. On the following line, write the location where you are saving the application and where 
all of the associated folders and files are to be saved: 

________________________________________________________ 

Note: Do not install Easy Print in the C:\Program Files directory. 

11. Select Everyone and click Next. 

 
The Confirm Installation window opens. 

T \E  P i t Fil \ 
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12. Click Next. 

When the installation finishes, the Installation Complete window opens. 

 

13. Click Close. 

The Medicare Remit Easy Print shortcut is available in the Medicare Remit Easy Print 
directory. Copy this shortcut to your desktop. 
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What Happens During the Installation Process? 

The following items are created and placed in the directory you designated under the Medicare 
Remit Easy Print folder in Step 4 of the Installation Instructions: 

 EasyPrint.exe 

 Easy Print icon (shortcut) 

 Import folder (location of active converted x835 files) 

 Archive folder (location of active converted x835 files. Inactive files are files not 
currently viewed in the application. 

 Native 835 folder (default location from which to import 835 files) 

 Report Export folder (where all exported Report files are stored) 

 Resource folder (internal folder to application) 
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Starting Medicare Remit Easy Print 
You can find shortcuts to the Medicare Remit Easy Print program in 2 places: 

 Your PC desktop:   

 The Start > Programs menu:   

Before You Start Medicare Remit Easy Print 
Before you start Medicare Remit Easy Print, you must: 

 Install Medicare Remit Easy Print (page 19). 

 To determine the location of the HIPAA 835 folder or where your HIPAA 835 files 
are stored, complete Step 4 of the Pre-Installation Checklist for Installation on a PC. 

 How to Start Medicare Remit Easy Print 
1. To start Medicare Remit Easy Print, double-click the Medicare Remit Easy Print shortcut.6 

The first time that you start Medicare Remit Easy Print, or when you don’t have any 
Remittance files in the Import folder you see the “No Remittance Files Found” dialog. 
Click or select OK to close the dialog. 

 
2. Click OK. 

                                                 
6 Hint: 

You can find the Medicare Remit Easy Print shortcut  on your desktop and on the Start menu. 
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Medicare Remit Easy Print opens with Import ready: 

 
3. Click Import. 
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A file dialog window opens permitting you to select the HIPAA 835 file to import. 

 
4. Select the HIPAA 835 file that you want to import by double-clicking it. 

Medicare Remit Easy Print starts the import to let you know that it is importing: 
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After the import finishes, the Remittance Advice List window appears. 
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Locating MREP and MREP File Locations on Your PC/Network 

Locating the MREP Application on Your PC/Network – Icon 
Available 

1. With your mouse, right click the icon on your desktop. 
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2. Go to Properties, Shortcut, Start in and you see the directory where the Medicare Remit 
Easy Print directory is located. 
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Locating the MREP Application on Your PC/Network – Icon not 
Available 

1. Click the Start menu. 

2. Select the ‘Search’ function. 

3. Select ‘For Files or Folders’. 

 
4. Select ‘All files and folders’. 
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5. Type ‘Medicare Remit Easy Print’ or the name you saved your MREP software under in 
‘All files and folders’. 

6. Select ‘My Computer’ from the ‘Look In’ drop-down box. 

 

7. Click Search. 
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Identifying Easy Print File Locations 
This tool contains the current path to folders containing the files that Medicare Remit Easy Print 
uses. In most cases, these paths never need updating. But, in certain situations, the user may want 
to override the default locations of these folders. 

1. To identify the necessary files/resources that Medicare Remit Easy Print is using, select 
Path Name Editor from the Tools menu.  
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2. The folder locations window appears showing the current folder location settings. 

 

The Imported files: folder contains those files once the native 835 files have been 
imported into Medicare Remit Easy Print. 

The Archive files: folder contains those files that have been archived from Medicare 
Remit Easy Print. 

The Exported reports: folder contains those report files where the user chose to export 
the reports rather than printing them. 

The X835 native files: folder contains the native 835 files that are imported into 
Medicare Remit Easy Print. 

Note: When an issue is reported and the GDIT MREP Team requests the file sent for 
further investigation, this is the type of file that needs to be sent. The file has a 
“.txt” extension. 

Identify the file/remittance advice in question or causing an issue. 

For the provider/supplier community, send a copy of this file to your contractor 
and your contractor should send the same file to the GDIT MREP Team. 

The Resource files: folder contains the necessary internal files (004010X091A1.FLD or 
005010x221A1.FLD and loop.str) for Medicare Remit Easy Print to run. The Codes.ini 
file is also in this folder, but it is not required for Medicare Remit Easy Print to run. (Note: 
The Codes.ini file contains the descriptions of the CARCs, RARCs, Group Codes, and 
Business Scenarios. If it is not present, you receive a generic default message.)  
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Buttons 

 Save changes made to the folders 

 Reset the values for the files back to what they were when the Medicare 
Remit Easy Print application was initially installed 

 Exit the Medicare Remit Easy Print Folder Locations display box without 
saving changes 
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Uninstalling Medicare Remit EasyPrint 
• Navigate to the Windows Control Panel Add/Remove Programs. 

• From the taskbar, click Start > Control Panel. 

• The Control Panel window opens. 

 

Windows 7 Control Panel 
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• Remove the Medicare Remit Easy Print Application. 

• Click Programs. 

• Click Programs and Features. 

• Select Medicare Remit Easy Print from the resulting list. 

 

• Click Remove, and then click Yes on the confirmation dialog. 

 

The Uninstall process is complete! 
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Online Help System 
The Medicare Remit Easy Print (MREP) Help online system allows you to look up 
information about MREP from MREP itself instead of referring to the Medicare Remit Easy 
Print User Guide. The online Help system is geared to the day-to-day tasks in MREP. It does 
not include information regarding the technical aspects of installing or running MREP on a PC 
or network. 

How to Access the Online Help System 
1. Open Medicare Remit Easy Print by double-clicking the Medicare Remit Easy Print icon

 . 

The Medicare Remit Easy Print Claim List tab opens. 

 

2. Click Help. 
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Medicare Remit Easy Print opens the Medicare Remit Easy Print Help window and 
displays the introduction. 

Note: Be sure that the Medicare Easy Print Help dialog box appears in the Contents tab 
in the left frame of the window. 
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How to Use the Contents Tab 
1. To see what’s inside a book, click the + sign. 
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2. Click a topic to display the topic. 

 

At this point, you can: 

Print the topic Click  

View Options Click  

Return to the previous view Click  

Hide the tab Click  
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How to Use the Index Tab 
1. Click the Index tab. 

 
2. Type a keyword to find. 
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3. Select a keyword by double clicking it or click the display. 

 

How to Use the Search Tab 
1. Click the Search tab. 
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2. Type a keyword to find, then click List Topics  or type Alt + L. 

 
3. Once the list of topics appears, double click the one you want. 

 

How to Close the Medicare Remit Easy Print Help Window 
Click Close Window  or type Alt + F4. 
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Importing HIPAA 835 files 
The first time that you start Medicare Remit Easy Print, you must import an HIPAA 835 file. 

For the procedure for the first import, see Step 1 of How to Start Medicare Remit Easy Print. 
 

The first time you start Medicare Remit Easy Print, or when you don’t have any Remittance 
files in the Import folder you see the “No Remittance Files Found” dialog. Click or select OK 
to close the dialog. 

Before You Import the HIPAA 835 File 
Before you import an HIPAA 835 file, you must: 

• Install the Medicare Remit Easy Print program. (See PC Installations  or Network 
Installations) 

• To determine the location of the HIPAA 835 folder or where your HIPAA 835 files 
are stored, complete Step 4 of the Pre-Installation Checklist for Installation on a PC. 

Import File Name Format 
When you import the HIPAA 835 file, Medicare Remit Easy Print makes a copy of it, renames 
it, and stores it in the Import file folder. 

The file-naming format is as follows: 

PPPPPPPPPPPPPPPPPPPPPPPPPPPPP  Payer Name – 30 bytes maximum 
 CCCCCCCCCCCCCCC Check/EFT # – 15 bytes maximum 

If a file has been imported successfully and you attempt to import the same file, an error 
record is written to the Import Exception Summary Window/Report and the file is not imported 
into the MREP application. Importing a file format other than HIPAA 835v5010A1 or 
835v4010A1, or a non-compliant version of a HIPAA 835-formatted file also writes a record 
to the Import Exception Summary window/report and the file is not imported into the MREP 
application. 

Note: With the release of MREP v2.9 (April 2011), the only acceptable versions of the 
HIPAA 835 file that can be imported into MREP are 835v5010A1 and 835v4010A1. 
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How to Import the HIPAA 835 File7 
1. Open Medicare Remit Easy Print by double-clicking the Medicare Remit Easy Print icon. 

The Medicare Remit Easy Print Claim List tab opens. 

 

2. Click Import or go to the File menu option and select Import. 

                                                 
7 Hint: 
For information about the very first time you import, see Step 1 on page 25. 
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Medicare Remit Easy Print opens a window for you to select the HIPAA 835 file to 
import: 

 
3. Select the HIPAA 835 file that you want to import by double-clicking it 

Medicare Remit Easy Print starts the import and lets you know that it is importing: 

 
After the import finishes, the MREP Remittance Advice List window appears. 

At this point, you can: 

Work with the MREP Remittance Advices  See Working with MREP Remittance Advices 
 

Work with Reports See Working with Reports 

Note: Medicare Remit Easy Print reformats and saves a copy of the HIPAA 835 file. 
This copy is the Import file. If you import the same HIPAA 835 file more than 
once, Medicare Remit Easy Print bypasses the duplicate file and displays the 
Import Exception Summary Report indicating duplicate remittances were 
detected. 

For information about making sense of the Import file name, see Import File Name 
Format. 
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How to Automatically Import the HIPAA 835 File 
• Close Medicare Remit Easy Print. Right click on the Easy Print icon and click Properties. 

The EasyPrint.exe Properties window appears. 

 
Note: The values in the various fields vary for each MREP user. 

• The Target: value needs to be modified to indicate the location of the files that are to be 
imported. The user must enter a space after the last double quote, the value of –I or –i (not 
case sensitive), followed by another space and the pathname. The pathname must be in 
double quotes. For example, "I:\Easy Print\EasyPrint.exe" –i "C:\MREP\Files to be 
imported\no_phi.txt" 
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• To save the changes you made to the Target: value, you must click Apply. 

 
• Once you click Apply, then you must click OK. The Properties window disappears. 
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• You can restart the MREP software. 
Notes: 

• If the user updates the Target field with a file path that does not exist, a message dialog 
appears stating the target file does not exist. Once the user chooses to close this window 
by clicking OK, the MREP software continues to run with the files that have already been 
imported. 

 
• Each time that the MREP software is invoked, it always accesses the import pathname to 

attempt to import the data that is contained in the specified file.  

• When a duplicate remit file or a file with an invalid data format (not 835v4010A1 or 
835v5010) is encountered, the Import Exception Summary window appears. The user can 
choose to Print or Close this window. Once the user chooses to close this window, the 
MREP software continues to run with files that have already been imported. 
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What to Do with an Import Error Message 
There are two error messages that you may see: 
For this error message: You need to: 
Invalid File Format Select the correct HIPAA 835 file to import. 

You have either selected an ERA not in a HIPAA 835 format or an 
ERA that is a HIPAA 835 with invalid delimiters. If you continue to 
receive this error, contact your contractor. 

Path / File Access Error Check with your network/PC administrator  
You need to have read/write access rights to the Medicare Remit 
Easy Print directory. 
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Import Exception Summary Window/Report 
The Import Exception Summary window/report helps to identify duplicate files, file 
formats other than HIPAA 835v5010 or HIPAA 835v4010A, non-compliant HIPAA 
835-formatted files, and prevents the posting of “junk” files to the import folder. If any 
of the scenarios that are described above are encountered while attempting to import 
files to the MREP application, an Import Exception Summary dialog displays a list of 
invalid files by Payee and Check/EFT #, in addition to a brief description of the issue 
encountered. 
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You have the option of closing the window or printing the Import Exception Summary. If you 
choose to print the Import Exception Summary report, the window does not close 
automatically once the report prints. You need to close the window using Close or “X-ing” 
out (top right corner of the Import Exception Summary window). The printing functionality 
for the Import Exception Summary report follows the existing printing functionality within 
MREP. Please note that if the window is closed prior to printing the report, the list of import 
error(s) is lost. To eliminate the need for file space management, a decision was made to not 
save the MREP Import Exception errors. To recreate the Import Exception Summary window, 
the files need to be imported again. 

The Import Exception Summary window and report contains three columns of information.  

• The first column of information is entitled “Payee”. Depending on what type of error 
is encountered during the import process, this field could contain data or spaces. The 
maximum number of bytes of data that can appear is 40.  

• The second column of information is entitled “Check/EFT #”. Depending on what type 
of error is encountered during the import process, this field could contain data or 
spaces. The maximum number of bytes of data that can appear is 15. 

• The third column of information is entitled “Reason”. Depending on what type of error 
that is encountered during the import process, there is the possibility of three different 
messages appearing. 

Prior to the three columns of data, the Import Exception Summary window and report 
contains a heading with the title “File:” The information following the “File:” heading is the 
location and name of the file that the attempt is being made to import into the MREP 
application.  

When the Import Exception Summary report prints, the printed version contains an additional 
heading prior the “File:” heading. It is the first heading on the report. On the left side of the 
page, the heading displays “Import Exception Summary”. In the center of the page, the 
heading displays the date and time stamp when the summary report was printed. The format 
of the date is MM/DD/CCYY. Please note that the leading zero in the month and day do not 
appear – for example: 2/15/2006. The format of the time is HH:MM:SS XX (XX represents 
AM or PM). On the right side of the page, the heading displays the version of the MREP 
application that is being used (for example: Easy Print v1.7). 
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Working with MREP Remittance Advices 

How to View a List of Claims for an MREP Remittance Advice 

1. Open Medicare Remit Easy Print by double-clicking the Medicare Remit Easy Print icon

 . 

The Medicare Remit Easy Print Claim List tab opens. 

2. Select the Remittance Advice by clicking it. 

Medicare Remit Easy Print highlights the Remittance Advice and lists the associated 
claims as show in the following image. 
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Note:  Some screen reading applications may not be able to read all of the values on the claim list tab. 
Function key F1 displays an accessibility informational message allowing the screen reading 
application to recite the field names and values displayed in the listview for the highlighted 
claim. Please note the Patient’s Name appears the Last Name first, followed by a comma and 
then the First Name:  

At this point, you can: 

Find out more about this tab See page Making Sense of the Claim List Tab 

Print the list Click   or go to the Tab menu 
option and select Print Claim List, or type Alt + B + 
P. 
For more info, see How to Print a List of Claims. 

View claim details Click  or go to the View 
menu option and select Claim Detail 
For more info, see How to View the Detail for a 
Claim 

  

View a Summary for the Remittance Advice  Click  or go to the View 
menu option and select Remit Summary 

For more info, see How to View the Total Amounts 
for a Remittance Advice. 

View the data that feeds the Remittance Advice  Click  or go to the View 
menu option and select Data View 

For more info, see Making Sense of the Data View 
Tab. 

Search Click  or go to the View 
menu option and select Search 

For more info, see How to Search Payment 
Information. 

View the CARCs, RARCs, Group Codes, and  

Business Scenarios for the Remittance Advice Click  or go to the View 
menu option and select Glossary. 
For more info, see Making Sense of the Glossary 
Tab. 
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How to View the Detail for a Claim 
1. Open Medicare Remit Easy Print by double-clicking the Medicare Remit Easy Print icon

 . 

The Medicare Remit Easy Print Claim List tab opens. 

2. Select the Remittance Advice by clicking it. 

Medicare Remit Easy Print highlights the Remittance Advice and lists the claims. 
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3. Check the checkbox next to the claim(s) that you want to see detail8. Detailed information 
only appears for claims that are checked. 

 

4. Click the Claim Detail tab.

                                                 
8 Hint: 
You can use the Check All and Uncheck All buttons to help you select the claims. 
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The detail appears for the claim you selected: 

 

Find out more about this tab See page Making Sense of the Claim Detail. 

Print the detail Click Print,  or go to the Tab menu 
option and select Print Claim Detail, or type Alt + B 
+ P. 
For more info, see How to Print the Detail for a 
Claim. 

Return to the Claim List  Click the claim list tab  or go 
to the View menu option and select Claim List. 
For more info, see How to View a List of Claims 
for an MREP Remittance Advice. 

 

View a Summary for the Remittance Advice  Click the summary tab  or 
go to the View menu option and select Remit 
Summary. 
For more info, see How to View the Total Amounts 
for a Remittance Advice. 
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View the data that feeds the Remittance Advice Click the Data View tab   or 
go to the View menu option and select Data View. 
For more info, see Making Sense of the Data View 
Tab. 

Search Click the Search Tab  or go 
to the View menu option and Search. 
For more info, see How to Search Payment 
Information. 

View the CARCs, RARCs, Group Codes, and  

Business Scenarios for the Remittance Advice Click the Glossary Tab  or 
go to the View menu option and select Glossary. 
For more info, see Making Sense of the Glossary 
Tab. 

Option to print or suppress the printing of  A check box with the word Glossary appears in the 
the glossary of CARCs and RARCs for the  lower right side of the Claim Detail tab. When this 
Remittance Advice (not available for  check box is checked, the glossary of CARCs and 
Remittance Advices printed from the  RARCs involved with a particular MREP 
menu bar or toolbar) Remittance Advice prints on a separate page. 

When the check box is not checked, the glossary 
of CARCs and RARCs involved with a particular 
MREP Remittance Advice does not print.  

You also have the option via the Tab menu option 
to show or not show the glossary of CARCs and 
RARCs involved with the MREP Remittance 
Advice. 
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How to View the Total Amounts for a Remittance Advice 
1. Open Medicare Remit Easy Print by double-clicking the Medicare Remit Easy Print icon. 

The Medicare Remit Easy Print Claim List tab opens.  

2. Select the Remittance Advice by clicking it. 

Medicare Remit Easy Print highlights the Remittance Advice and lists the claims below. 

3. Click the Remit Summary Tab  or type Alt + V + S.  
Medicare Remit Easy Print displays the totals, for example 
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At this point, you can: 
Find out more about this tab See Making Sense of the Remit Summary Tab. 
 

Print the summary Click Print  or go to the Tab menu 
option and select Print Claim Detail or type Alt + B 
+ P. 

View claim details Click the Claim Detail Tab  or 
go to the View menu option and select Claim 
Detail 
For more info, see How to View the Detail for a 
Claim. 

 

Return to the Claim List  Click the Claim List tab  or go 
to the View menu option and select Claim List 
For more info, see How to View a List of Claims 
for an MREP Remittance Advice. 

 

View the data that feeds the Remittance Advice Click the Data View tab  or go 
to the View menu option and select Data View 
For more info, see Making Sense of the Data View 
Tab. 

Search Click the Search tab  or go to 
the View menu option and select Search 
For more info, see How to Search Payment 
Information. 

View the CARCs, RARCs, Group Codes, and  Click the Glossary tab   or go 
Business Scenarios for the Remittance Advice to the View menu option and select Glossary 

For more info, see Making Sense of the Glossary 
Tab. 



Medicare Remit Easy Print Working with MREP Remittance Advices 

© 2016 Sponsored by the Centers for Medicare & Medicaid Services (CMS)  
under contract HHSM-500-2007-00021I/HHSM-500-T0008 – VMS Maintenance.  This document contains confidential and 

 proprietary information, which shall not be used, disclosed, or reproduced without the express written consent of CMS. 

62 

How to View the Data in the Import File 
1. Open Medicare Remit Easy Print by double-clicking the Medicare Remit Easy Print icon. 

The Medicare Remit Easy Print Claim List tab opens.  

2. Select the Remittance Advice by clicking it. 

Medicare Remit Easy Print highlights the Remittance Advice and lists the claims. 

3. Click the Data View Tab  or type Alt + VV. 
Medicare Remit Easy Print displays the file format: 
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At this point, you can: 
Find out more about this window See page Making Sense of the Data View Tab. 

View claim details Click the Claim Detail tab  or, 
go to the View menu option and select Claim 
Detail. 
For more info, see How to View the Detail for a 
Claim. 

Return to the Claim List  Click the Claim List tab  or 
go to the View menu option and select Claim List. 
For more info, see How to View a List of Claims 
for an MREP Remittance Advice. 

View a Summary for the Remittance Advice  Click the Summary tab  or, 
go to the View menu option and select Remit 
Summary. 
For more info, see How to View the Total Amounts 
for a Remittance Advice. 

Search Select the Search tab or, go 
to the View menu option and select Search. 
For more info, see How to Search Payment 
Information. 

View the CARCs and RARCs for the  Select the Glossary tab  
Remittance Advice or, go to the View menu option and select 

Glossary. 
For more info, see Making Sense of the Glossary 
Tab. 
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How to View the CARC and RARC Codes 
1. Open Medicare Remit Easy Print by double-clicking the Medicare Remit Easy Print icon. 

The Medicare Remit Easy Print Claim List tab opens. 

2. Select the Remittance Advice by clicking it. 

Medicare Remit Easy Print highlights the Remittance Advice and lists the claims below. 

3. Click the Glossary Tab  or type Alt +V + G. 

Medicare Remit Easy Print shows the Reason and Remark codes for the Remittance 
Advice: 
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At this point, you can: 

Find out more about this tab  See page Making Sense of the Glossary Tab 

View claim details  Click the Claim Detail tab  or go 
to the View menu option and select Claim Detail. 
For more info, see How to View the Detail for a 
Claim. 

Return to the Claim List  Click the Claim List tab   or go to 
the View menu option and select Claim List. 
For more info, see How to View a List of Claims for 
an MREP Remittance Advice. 

View a Summary for the Remittance  Click the Summary tab  or go to 
Advice  the View menu option and select Remit Summary. 

For more info, see How to View the Total Amounts 
for a Remittance Advice on page 91. 

View the data that feeds the  Select the Data View tab   or go 
Remittance Advice to the View menu option and select Data View. 

For more info, see Making Sense of the Data View 
Tab. 

Search Select the Search tab  or go to the 
View menu option and select Search. 
For more info, see How to Search Payment 
Information. 

View the CARCs and RARCs for Click Codes   at the  
the Remittance Advice bottom of the tab or type Alt + B + C. 

For more information, see How to View the CARC 
and RARC Codes 
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How to Look up a CARC/RARC Code, Group Code, or CORE 
Business Scenario 

1. Open Medicare Remit Easy Print by double-clicking   . 

The Medicare Remit Easy Print Claim List tab opens. 

2. On the menu Select Tools > Code Descriptions.  

The Code Descriptions window opens. 
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How to Update (Import) the CARC/RARC Codes, Group Codes, 
and CORE Business Scenarios 

At a minimum, the ANSI Claim Adjustment Reason Code (CARC) and Remittance Advice 
Remark Code (RARC) file requires an update three times a year. When the list of codes is updated 
per Washington Publishing Company, GDIT provides an updated file on the VMS ETS website 
for the contractors and CMS provides a link to the updated file on the CMS website for the 
provider/supplier community. When the user finds it necessary to import this updated file into 
MREP, follow these instructions: 

1. Access the list of the latest codes from the VMS ETS or CMS website. 

2. Save the list of latest codes so they are easily accessible. 

Note: The file name must be saved as Codes.ini for MREP to successfully find the code file. 

3. Select Import Code Descriptions from the Tools menu. 
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A dialog window appears asking to confirm the code import. 

 

If you select NO, the dialog box disappears and no updates are made to MREP. If you 
select YES, another file dialog box appears. 

 

4. Navigate to the folder or area where you saved the file under step 2. Select the Codes.ini 
file and then click Open. 
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5. After you press Open, a dialog displays confirming the code import was successful. Click, 
or select OK to close the dialog. 

 

Click OK. 

6. The latest list of CARC/RARCs exists in the MREP application. To verify that the latest 
version exists, select Code Descriptions from the Tools menu.  
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7. The Easy Print – Reason/Remark/Group Codes dialog box appears.  

Note:  The Easy Print – Reason/Remark/Group Codes dialog box includes the date of the 
latest version of the code list. 
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How to Print a List of Claims 
1. View the list of claims. 

For the steps to follow, see How to View a List of Claims for an MREP Remittance Advice. 

2. Click Print  at the bottom of the tab or type Alt + B + P.  

The Print remit listing window opens. 

3. Print the detail listing in one of the following ways: 

A. From the Print remit listing window, click Print to print the detail without previewing 
it. 

 
The Print dialog opens. 

 
If you need to change the properties, click Properties and make changes as necessary. 

Click OK. Medicare Remit Easy Print prints the detail at your default printer. 

B. From the Print remit listing window, click Preview to view a preview of the printed 
page before printing. 
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The Print Preview window opens. 

 

Click the Printer  at the top of the window. 

Medicare Remit Easy Print prints the detail at your default printer. 

At this point, you can: 

View claim details Click the Claim Detail tab  or 
go to the View menu option and select Claim 
Detail  
For more info, see How to View the Detail for a 
Claim. 

 

Search Click the Search tab  or go to 
the View menu option and select Search 
For more info, see How to Search Payment 
Information. 

View a Summary for the Remittance Advice Click the Summary tab   or 
go to the View menu option and select Remit 
Summary 
For more info, see How to View the Total Amounts 
for a Remittance Advice 

View the data that feeds the Remittance Advice Click the Data View tab  or 
go to the View menu option and select Data View 
For more info, see Making Sense of the Data View 
Tab. 

View the CARCs, RARCs, Group Codes, and  Click the Glossary tab  
Business Scenarios for the Remittance Advice or go to the View menu option and select Glossary 

For more info, see How to View the CARC and 
RARC Codes. 
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How to Print the Detail for a Claim 
1. View the detail for the claim.  

For the steps to follow, see How to View the Detail for a Claim. 
 

2. Click print  at the bottom of the tab, or type Alt + B + P. The Print remit 
listing window opens. 

 
3. Print the detail listing in one of the following ways: 

A. Click Print to print the detail without previewing it. 

The Print dialog box opens. 

 
If you need to change the properties, click Properties and make changes as necessary. 

Click OK. Medicare Remit Easy Print prints the detail at your default printer. 
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B. Click Preview to view a preview of the printed page before printing. 

 

The Print Preview window opens. 

 

Click Printer  at the top of the window. 

Medicare Remit Easy Print prints the detail at your default printer. 
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How to Print the Remittance Advice Summary 
1. View the Remittance Advice Summary. 

For the steps to follow, see How to View the Total Amounts for a Remittance Advice. 

2. Click Print  at the bottom of the tab, or type Alt + B + P.  

The Print remit listing window opens. 

3. Print the detail listing in one of the following ways: 

A. Click Print to print the detail without previewing it. 

 
The Print dialog box opens. 

 
If you need to change the properties, click Properties and make changes as necessary. 

Click OK. Medicare Remit Easy Print prints the detail at your default printer.  
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B. Click Preview to view a preview of the printed page before printing. 

 
The Print Preview window opens. 

 

Click Printer  at the top of the window. 

Medicare Remit Easy Print prints the detail at your default printer. 
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Searching Payment Information 
You can search by: 

• Adjusted Lines 

• Bene Account Number 

• Bene Last Name 

• CARC 

• COB Claims 

• Coinsurance Lines 

• Deductible Lines 

• Deductible/Coins Lines 

• Denied Lines  

• HICN 

• ICN 

• MSP Claims 

• NDC 

• Non-COB Claims 

• Non-MSP Claims 

• Other Adjustments 

• Procedure Code 

• Rendering Provider Number 

• Service Date (range of dates in the format DD, DD/YY, MM, MM/DD, MM/DD/YY, 
MM/YY, or YY; forward slashes are not required when entering a value in the Value 
to Find field) 
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How to Search Payment Information 
1. Open Medicare Remit Easy Print by double-clicking the Medicare Remit Easy Print icon. 

  
The Medicare Remit Easy Print Claim List tab opens.  
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2. Click Search or use the Search tab. 

The Search tab opens. 
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3. Use the drop-down list to select a search field. 9 

If applicable, enter the value to find. The Search tab includes three options for how to 
search the field (Exact Match, Begins With, or Contains).  

To display the “searched” data, you must select one of the options before clicking Search. 
The Exact Match Begins With, and Contains options are only available for the HICN, 
ICN, Bene Account Number, Bene Last Name, NDC, Procedure Code, and Rendering 
Provider fields.  

If the Search: field is not one of these fields, the Exact Match, Begins With, and Contains 
options are not available. 

If you select one of the Service Date formats from the drop-down menu, you can: 

• Enter the date in the Value to find field10 
• Use the drop-down list only to access the Calendar picker for the MM/DD/YY 

format only. Use the left and right arrows to select the month, and then click 
the date you want. 

 

                                                 
9 Hint: 
You cannot use a wild card character in the search. 
10 Hint: 
You can use a calendar date picker to select a service date. 
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5. Click the Search type to start the search. 

Medicare Remit Easy Print returns all of the claim lines/info that match the search.  

For example, imagine you needed to view all of Sally Doe’s claims. If the remit contains 
any claim lines with the name Doe, the Search Tab list view is updated with those claim 
lines matching the criteria. 
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Making Sense of the Claim List Tab 
For the procedure to view the claim list, see How to View a List of Claims for an MREP 
Remittance Advice. 

The claim list tab displays a summary of all of the claims found within the selected 
remittance:11 

 

Name This is the name of the beneficiary that the claim was 
processed for. The name field is defined as Last Name 
followed by the First Name. A comma separates the two 
names. 

ACNT This is any internal number assigned to the claim by the 
provider. 

                                                 
11 Hint: 
F1 displays a dialog box containing the listview field names and values. This enables screen reading programs to read all 
the listview fields for a highlighted claim. 
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ICN This is the Internal Control Number (ICN), the unique 
number assigned to the claim when it is received by the 
contractor.  

Billed Amount This is the total claim dollar billed amount. 

Paid Amount This is the total claim provider billed amount. 
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From Date This is the earliest From Date of service on the claim. 

To Date This is the latest To Date of service on the claim. 

ASG This indicates whether or not the provider has accepted 
assignment for the claim. 

Buttons 

 Print the list; or type Alt + B + P 

 Select all of the claims; or type Alt + B + C 

 Unselect all of the claims; or type Alt + B + U 

 View the data that feeds the remittance advice; or type Alt + V+ V 

Display Claim(s) 

Select claims in the claim list by clicking the checkbox for the corresponding claim. To display the 
selected claims, select Display Claim from the Tab dropdown list. 
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EasyPrint displays the claim(s) information in a vertical line-by-line format. 

 

This format provides the claim data at a glance and allows screen reading software to 
interpret the data more easily. 
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Making Sense of the Claim Detail Tab 

For the procedure to view claim detail, see How to View the Detail for a Claim. 

The Claim Detail tab displays all the claim information for each claim(s) that has been 
checked on the Claim List tab. 

  

INFORMATION FOR THE CLAIM: 

Note: This is an image of the lower part of the window. 

First Line of Claim Line  

NAME This is the name of the beneficiary for whom the claim was 
processed. 

HIC This is the Health Insurance Claim (HIC) number of the 
beneficiary for whom the claim was processed. 

ACNT This is any internal number assigned to the claim by the 
provider. 

ICN Internal Control Number (ICN); the unique number 
assigned to the claim when it is received by the contractor. 

ASG Shows whether or not the provider has accepted 
assignment for the claim. 

MOA Remark codes at the claim level. 
REND-PROV Performing provider’s ID number.  
SERV-DATE Date(s) of service. 
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POS Two-digit Place of Service (POS) code  
A list of POS codes is available here: 
http://www.cms.gov/manuals/downloads/clm104c26.pdf 

PD-PROC HCPCS procedure code 
A list of these codes is available here: 
https://www.cms.gov/CLIA/downloads/Subject.to.CLIA.pdf  

MODS Modifiers billed with the procedure. 
PD-NOS Number of services rendered. 
BILLED Amount the provider billed for the service. 
ALLOWED Allowed amount for the service. 
DEDUCT Amount of any deductible applied to the claim.  

This is the amount that the beneficiary (or other insurer, if 
applicable) is responsible for paying the provider. 

COINS Amount that the beneficiary (or other insurer, if applicable) 
is responsible for paying the provider. 

PROV-PD Amount the provider was paid for the service. 

Second Line of Claim Line 

RARC Remittance Advice Remark Codes at the line level. 
SUB-NOS Submitted number of services. 
SUB-PROC HCPCS procedure code 
GRP/CARC Group Codes and Claim Adjustment Reason Codes for the 

service line 
CARC-AMT Amount of any adjustment made based on the Group and 

Claims Adjustment Reason Code 
ADJ-QTY Quantity of units of service being adjusted 
BS CORE-defined Business Scenarios associated with the 

Claim Adjustment Reason Code  
CNTL # Line item control number. 
HCPI Healthcare Policy Identification number 
Totals 

PT RESP Total amount that the beneficiary owes the provider for this claim 
CARC Total amount of all claim adjustments on all service lines 
CLAIM TOTALS Totals for all service-line level amounts: 

BILLED 
ALLOWED 
DEDUCT 
COINS 
PROV-PD 
ADJ TO TOTALS: 

PREV PD Blank in Medicare Remit Easy Print 
INTEREST Interest amount paid for claims processing time 
LATE FILING CHARGE Late filing charge 
NET Amount that Medicare owes the provider for this claim 
CLAIM INFORMATION  Appears when the claim is forwarded to a 
FORWARDED TO: beneficiary’s supplemental insurer 
CORRECTED PRIORITY  Corrected priority payer name and/or id number 
PAYER INFO: 
OTHER CLAIM REL  Additional information relevant to the adjudication 
IDENTIFICATION: of the claim and a qualifier identifying the type of reference information 

http://www.cms.gov/manuals/downloads/clm104c26.pdf
https://www.cms.gov/CLIA/downloads/Subject.to.CLIA.pdf


Medicare Remit Easy Print Working with MREP Remittance Advices 

© 2016 Sponsored by the Centers for Medicare & Medicaid Services (CMS)  
under contract HHSM-500-2007-00021I/HHSM-500-T0008 – VMS Maintenance.  This document contains confidential and 

 proprietary information, which shall not be used, disclosed, or reproduced without the express written consent of CMS. 

88 

GLOSSARY Reason, Remark, Group codes, and Business Scenarios that are also 
shown on the Glossary tab 

Buttons 

 Print the claim detail; or press Alt + B + P 

 Make the size of the type larger; or press Alt + B + I 

 Make the size of the type smaller; or press Alt + B + O 

 Reset the type to the original size; or press Alt + B + R 

 Check to see CARCs/RARCs and Business Scenarios with descriptions 
for the selected claims; or press Alt + B + S 
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Making Sense of the Remit Summary Tab 
For the procedure to view the Remittance Advice detail, see How to View the Total Amounts 
for a Remittance Advice. 

The Remit Summary Tab displays total dollar amounts, claim counts, and provider adjustment 
information if present in the selected remittance. 

 

PROVIDER NAME Provider’s name 
PROVIDER # Provider’s ID number 
CHECK DATE Date of the check 
CHECK /EFT TRACE NUMBER Tracking number for the check or EFT 
TOTAL CLAIMS Total number of claims 
BILLED AMOUNT Total billed amount 
TOTAL REASON CODE Total adjustment amount. 
ADJUSTMENT AMOUNT 
TOTAL ALLOWED AMOUNT Total allowed amount 
TOTAL COINSURANCE AMOUNT Total amount of coinsurance applied 
TOTAL DEDUCTIBLE AMOUNT Total deductible amount 
TOTAL PAID TO PROVIDER Total amount paid to provider. 
TOTAL INTEREST AMOUNT Total amount of interest applied. 
TOTAL CHECK /EFT AMOUNT Total amount of the check. 
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PLB ADJ DETAILS Remittance-level (PLB) adjustment 
This field only appears if a remittance-level adjustment is 
present. 

Buttons 

 Print the summary; or type Alt + B + P 

 Make the size of the type larger; or type Alt + B + I 

 Make the size of the type smaller; or type Alt + B + O 

 Reset the type to its original size; or type Alt + B + R 
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Making Sense of the Data View Tab 
For the procedure to view the data, see How to View the Data in the Import File. 

The Data View Tab displays the remittance fields as they are stored internally in MREP. The 
data are stored in what are referred to as Segments. Each segment contains a varying number 
of elements or fields. 

 

The X12 835 5010 formats separate data into segments and loops. To understand how to read 
segments and loops, refer to the X12 835 Implementation Guide, which is available through 
the Washington Publishing Company at www.wpc-edi.com and the CMS Standard 
Companion Guide Transaction Information: Instructions related to the 835 Health Care Claim 
Payment/Advice based on ASC X12 Technical Report Type 3 (TR3), version 005010A1 
https://www.cms.gov/medicare/billing/electronicbillingeditrans/downloads/5010a1835cg.pdf.  

http://www.wpc-edi.com/
https://www.cms.gov/medicare/billing/electronicbillingeditrans/downloads/5010a1835cg.pdf
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Making Sense of the Search Tab 
For the procedure to view the data, see How to Search Payment Information. 

The Search tab displays a summarized list of claim information that matches the criteria of the 
user’s search. The Name field’s format is the beneficiary’s Last Name, followed by a comma 
and then the First Name. 

 
Buttons 

 Print the list of claims from the search; or type Alt + B + P 

 View details for all of the claims from the search; or type Alt + B + C 
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Making Sense of the Glossary Tab 
For the procedure to view the data shown in the Glossary Tab see How to View the CARC and 
RARC Codes. 

The Glossary tab displays the CAGC/CARC/RARC code and Business Scenario with 
descriptions for the selected remittance. 

 
Buttons 

 Make the size of the type larger; or type Alt + B + I 

 Make the size of the type smaller; or type Alt + B + O 

 Reset the type to its original size; type Alt + B + R 

 Displays CARCs/RARCs and descriptions for the selected claims when 
checked; or type Alt + B + S 
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Working with Reports 
Medicare Remit Easy Print provides 11 different reports: 

• Denied Service Lines 

• Adjusted Service Lines 

• Deductible Service Lines 

• Coinsurance Service Lines 

• Deductible/Coinsurance Service Lines 

• COB Claims Report 

• Non-COB Claims Report 

• MSP Claims Report 

• Non-MSP Claims Report 

• Other Adjustment Report 

• Entire Remittance 
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Making Sense of the Denied Service Lines Report 
This report displays claim service lines that have an allowed amount equal to zero and are 
associated with a claim that does NOT have a claim status 22 (reversed claim). The report 
includes only the lines on the claim that meet these criteria.  
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Making Sense of the Adjusted Service Lines Report 
This report displays claims that have a status of 22 (reversed claim). 

This report does NOT show the adjustment claim that reflects the corrected dollar amounts. 
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Making Sense of the Deductible Service Lines Report 
This report shows claim service lines that have deductible amounts greater than zero, as well 
as those service lines with only deductible amounts greater than zero. It includes only the lines 
on the claim that meet these criteria. 
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Making Sense of the Coinsurance Service Lines Report 
This report shows claim service lines that have coinsurance amounts greater than zero, as well 
as those service lines with only coinsurance amounts greater than zero. It includes only the 
lines on the claim that meet these criteria. 
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Making Sense of the Deductible/Coinsurance Service Lines Report 
This report shows claim service lines that have both deductible and coinsurance amounts 
greater than zero, as well as those service lines with only coinsurance and deductible amounts 
greater than zero. It includes only the lines on the claim that meet these criteria. 
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Making Sense of the COB Claims Report 
This report shows those claims on the HIPAA 835v4010A1 or 835v5010 file that were crossed 
over. The requirement for crossover claims to print on the report is that the 2100 loop; CLP02 
data field must contain one of the following values: 

19 Processed as Primary, Forwarded to Additional Payer(s) 

20 Processed as Secondary, Forwarded to Additional Payer(s) 

21 Processed as Tertiary, Forward to Additional Payer(s) 
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Making Sense of the Non-COB Claims Report 
This report shows those claims on the HIPAA 835v4010A1 or 835v5010 file that did not cross 
over. The requirement for claims to print on the report is that the 2100.CLP02 data field does 
not contain one of the following values: 

19 Processed as Primary, Forwarded to Additional Payer(s) 

20 Processed as Secondary, Forwarded to Additional Payer(s) 

22 Processed as Tertiary, Forward to Additional Payer(s) 
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Making Sense of the MSP Claims Report 
This report contains those claims, within a remittance, on the HIPAA 835v4010A1 or 
835v5010 file that were processed by Medicare as secondary. The claims have a value of 2 
(Processed as Secondary) or 20 (Processed as Secondary, Forwarded to Additional Payer(s)) in 
the 2100 loop, CLP02 data field. 
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Making Sense of the Non-MSP Claims Report 
This report contains those claims, within a remittance, on the HIPAA 835v4010A1 or 
835v5010 file that were processed by Medicare as primary. The claims have a value of 1 
(Processed as Primary) or 19 (Processed as Primary, Forwarded to Additional Payer(s)) in the 
2100.CLP02 data field. 
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Making Sense of the Other Adjustments Report 
This report shows those claims on the HIPAA 835v4010A1 or 835v5010 file that had some type of 
adjustment. Claims that have Late Filing and Interest and remittances that have Withholding and a 
Forwarding Balance appear on the report. 

 



Medicare Remit Easy Print Working with Reports 

© 2016 Sponsored by the Centers for Medicare & Medicaid Services (CMS)  
under contract HHSM-500-2007-00021I/HHSM-500-T0008 – VMS Maintenance.  This document contains confidential and 

 proprietary information, which shall not be used, disclosed, or reproduced without the express written consent of CMS. 

105 

Making Sense of the Entire Remittance Report 
This report contains the entire remittance report for the provider or supplier. You see the same 
information that was sent to the provider or supplier. 
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How to Print the Denied Service Lines Report 
1. Open Medicare Remit Easy Print by double-clicking the Medicare Remit Easy Print icon. 

  
The Medicare Remit Easy Print Claim List tab opens. 

 

A. Click the down arrow on Report. 

The Report List appears.  
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3.  Select Denied Service Lines.  
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4. The Print and Export options appear:   

 
5. Select Print. 

The Print denied line report window opens. 

 

6. Print the detail listing in one of the following ways: 

A. From the Print denied line report window, click Print to print the detail without 
previewing it. 
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The Print dialog opens, for example: 

 
If you need to change the properties, click Properties and make changes as necessary. 

Click OK. Medicare Remit Easy Print prints the detail at your default printer. 

B. From the Print denied line report window, click Preview to see a preview of the 
printed page before printing. 

The Print Preview window opens 

 

. 

Click Printer  at the top of the window. 

Medicare Remit Easy Print prints the detail at your default printer. 
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How to Export the Denied Service Lines Report 
You export the report in .csv (comma separated values) format. 

1. Open Medicare Remit Easy Print by double-clicking the Medicare Remit Easy Print icon. 

The Medicare Remit Easy Print Claim List tab opens.  

 
2. Click the down arrow on Report. 

The Report List appears. 
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3. Select Denied Service Lines. 

The Print and Export options appear. 
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4. Select Export. 
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The Export folder window opens.12 

 
5. Enter the file name. 

6. Click Save. 

                                                 
12 Hint: 
When you export, the default folder is the ReportExport folder in the Medicare Remit Easy Print directory.  

You can select another location using the Save in drop-down list menu 
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How to Print the Adjusted Service Lines Report 
1. Open Medicare Remit Easy Print by double-clicking the Medicare Remit Easy Print icon. 

The Medicare Remit Easy Print Claim List tab opens.  

 
2. Click the down arrow on Report. 



Medicare Remit Easy Print Working with Reports 

© 2016 Sponsored by the Centers for Medicare & Medicaid Services (CMS)  
under contract HHSM-500-2007-00021I/HHSM-500-T0008 – VMS Maintenance.  This document contains confidential and 

 proprietary information, which shall not be used, disclosed, or reproduced without the express written consent of CMS. 

115 

The Report List appears. 

 
3. Select Adjusted Service Lines. 
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The Print and Export options appear. 

 
4. Select Print. The Print remit listing window appears. 

5. From the Print remit listing window, print the detail listing in one of the following ways: 

C. Click Print to print the detail without previewing it. 
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The Print dialog opens, for example: 

 
If you need to change the properties, click Properties and make changes as necessary. 

Click OK. Medicare Remit Easy Print prints the detail at your default printer. 

D. Click Preview to view a preview of the printed page before printing. 

 
The Print Preview window opens. 

 

Click Printer  at the top of the window. 

Medicare Remit Easy Print prints the detail at your default printer. 
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How to Export the Adjusted Service Lines Report 
1. Open Medicare Remit Easy Print by double-clicking the Medicare Remit Easy Print icon. 

The Medicare Remit Easy Print Claim List tab opens.  

 
2. Click the down arrow on Report. 
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The Report List appears. 

 
3. Select Adjusted Service Lines. 
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The Print and Export options appear. 

 
4. Select Export. 
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The Export folder window opens.12 

 

5. Enter the file name. 

6. Click Save. 
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How to Print the Deductible Service Lines Report 
1. Open Medicare Remit Easy Print by double-clicking the Medicare Remit Easy Print icon. 

  
The Medicare Remit Easy Print Claim List tab opens.  

 
2. Click the down arrow on Report. 
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The Report List appears.  

 
3. Select Deductible/COINS Service Lines. 
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The Deductive/COINS Service Lines report options appear. 

 
4. Select Deductible Lines: 
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5. Select Print. The Print remit listing window appears. 

6. Print the detail listing in one of the following ways: 

A. Click Print to print the detail without previewing it. 
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The Print dialog opens. 

 
If you need to change the properties, click Properties and make changes as necessary. 

Click OK. Medicare Remit Easy Print prints the detail at your default printer. 

B. Click Preview to view a preview of the printed page before printing. 

 
The Print Preview window opens. 

 

Click Printer  at the top of the window. 

Medicare Remit Easy Print prints the detail at your default printer. 
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How to Export the Deductible Service Lines Report 
1. Open Medicare Remit Easy Print by double-clicking the Medicare Remit Easy Print icon. 

The Medicare Remit Easy Print Claim List tab opens.  

 
2. Click the down arrow on Report. 



Medicare Remit Easy Print Working with Reports 

© 2016 Sponsored by the Centers for Medicare & Medicaid Services (CMS)  
under contract HHSM-500-2007-00021I/HHSM-500-T0008 – VMS Maintenance.  This document contains confidential and 

 proprietary information, which shall not be used, disclosed, or reproduced without the express written consent of CMS. 

128 

The Report List appears.  

 
3. Select Deductible/COINS Service Lines. 



Medicare Remit Easy Print Working with Reports 

© 2016 Sponsored by the Centers for Medicare & Medicaid Services (CMS)  
under contract HHSM-500-2007-00021I/HHSM-500-T0008 – VMS Maintenance.  This document contains confidential and 

 proprietary information, which shall not be used, disclosed, or reproduced without the express written consent of CMS. 

129 

The Deductible/COIN Service Lines report options appear. 

 
4. Select Deductible Lines. 
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5. Select Export. 
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6. The Export folder window opens.12 

 

6. Enter the file name. 

7. Click Save. 
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How to Print the Coinsurance Service Lines Report 
1. Open Medicare Remit Easy Print by double-clicking the Medicare Remit Easy Print icon. 

 
The Medicare Remit Easy Print Claim List tab opens.  

 
A. Click the down arrow on Report. 
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The Report List appears.  

 
2. Select Deductible/COINS Service Lines. 
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The Deductible/COINS Service Lines report options appear. 

 
3. Select Coinsurance Lines. 
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4. Select Print. The Print remit listing window appears. 

5. Print the detail listing in one of the following ways: 

B. From the Print remit listing window, click Print to print the detail without previewing 
it. 
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The Print dialog opens. 

 
If you need to change the properties, click Properties and make changes as necessary. 

Click OK. Medicare Remit Easy Print prints the detail at your default printer. 

C. From the Print remit listing window, click Preview to view a preview of the printed 
page before printing. 
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The Print Preview window opens. 

 

D. Click Printer  at the top of the window. 

Medicare Remit Easy Print prints the detail at your default printer. 
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How to Export the Coinsurance Service Lines Report 
1. Open Medicare Remit Easy Print by double-clicking the Medicare Remit Easy Print icon. 

The Medicare Remit Easy Print Claim List tab opens.  

 
2. Click the down arrow on Report.
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The Report List appears.  

 
3. Select Deductible/COINS Service Lines. 
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The Deductible/COIN report options appear. 

 
4. Select Coinsurance Lines. 
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5. Select Export. 
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The Export folder window opens.12 

 

6. Enter the file name. 

7. Click Save. 
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How to Print the Deductible/Coinsurance Service Lines Report 
1. Open Medicare Remit Easy Print by double-clicking the Medicare Remit Easy Print icon. 

  
The Medicare Remit Easy Print Claim List tab opens.  

 
2. Click the down arrow on Report. 
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The Report List appears.  

 
3. Select Deductible/COINS Service Lines. 
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The Deductible/COIN report options appear. 

 
4. Select Deductible & Coinsurance Lines: 
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5. Select Print.  

The Print remit listing window appears. 

6. Print the detail listing in one of the following ways: 

A.  From the Print remit listing window, click Print to print the detail without previewing 
it. 
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The Print dialog box opens. 

 
If you need to change the properties, click Properties and make changes as necessary. 

Click OK. Medicare Remit Easy Print prints the detail at your default printer. 

7. From the Print remit listing window, click Preview to view a preview of the printed page 
before printing. 

 

 

Click Printer  at the top of the window. 

Medicare Remit Easy Print prints the detail at your default printer. 
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How to Export the Deductible/Coinsurance Service Lines Report 
1. Open Medicare Remit Easy Print by double-clicking the Medicare Remit Easy Print icon. 

The Medicare Remit Easy Print Claim List tab opens.  

 
2. Click the down arrow on Report. 
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The Report List appears.  

 
3. Select Deductible/COINS Service Lines. 
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The Deductible/COINS report options appear. 

 
4. Select the Deductible & Coinsurance Lines: 
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5. Select Export. 
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The Export folder window opens.12 

  

6. Enter the file name. 

7. Click Save. 
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How to Print the COB Claims Report 
1. Open Medicare Remit Easy Print by double-clicking the Medicare Remit Easy Print icon. 

  
The Medicare Remit Easy Print Claim List tab opens.  

 
2. Click the down arrow on Report. 
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The Report List appears. 

 
3. Select COB/Non-COB Claims.  
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The Print and Export options appear. 

 

4. Select COB Claims. 
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5. Select Print. 

The Print denied line report window opens. 

6. Print the detail listing in one of the following ways: 

A. From the Print denied line report window, click Print to print the detail without 
previewing it. 
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The Print dialog box opens. 

 
If you need to change the properties, click Properties and make changes as necessary. 

Click OK. Medicare Remit Easy Print prints the detail at your default printer. 

7. From the Print denied line report window, click Preview to view a preview of the printed 
page before printing. 

 
The Print Preview window opens. 

 

Click Printer  at the top of the window. 

Medicare Remit Easy Print prints the detail at your default printer. 
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How to Export the COB Claims Report 
You export the report in .csv (comma separated values) format. 

1. Open Medicare Remit Easy Print by double-clicking the Medicare Remit Easy Print icon. 

The Medicare Remit Easy Print Claim List tab opens.  

 
2. Click the down arrow on Report. 
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The Report List appears. 

 
3. Select COB/Non-COB Claims.  
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4. Select COB Claims. 

The Print and Export options appear. 

 
5. Select Export. 
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The Export folder window opens.13 

 

6. Enter the file name. 

7. Click Save. 

                                                 
13 Hint: 
When you export, the default folder is the ReportExport folder in the Medicare Remit Easy Print directory. You can select 
another location using the Save in drop-down list menu 
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How to Print the Non-COB Claims Report 
1. Open Medicare Remit Easy Print by double-clicking the Medicare Remit Easy Print icon. 

  
The Medicare Remit Easy Print Claim List tab opens.  

 
2. Click the down arrow on Report. 
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The Report List appears. 

 
3. Select COB/Non-COB Claims.  
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4. Select Non-COB Claims. 

The Print and Export options appear. 
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5. Select Print. 

The Print denied line report window opens. 

6. Print the detail listing in one of the following ways: 

A. From the Print denied line report window, click Print to print the detail without 
previewing it. 
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The Print dialog opens, for example: 

 
If you need to change the properties, click Properties and make changes as necessary. 

Click OK. Medicare Remit Easy Print prints the detail at your default printer. 

7. From the Print denied line report window, click Preview to view a preview of the printed 
page before printing. 

 
The Print Preview window opens. 

 

Click Printer  at the top of the window. 

Medicare Remit Easy Print prints the detail at your default printer. 
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How to Export the Non-COB Claims Report 
You export the report in .csv (comma separated values) format. 

1. Open Medicare Remit Easy Print by double-clicking the Medicare Remit Easy Print icon.

  
The Medicare Remit Easy Print Claim List tab opens.  

 
2. Click the down arrow on Report. 
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The Report List appears. 

 
3. Select COB/Non-COB Claims.  
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4. Select Non-COB Claims. 
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The Print and Export options appear. 

 
5. Select Export. 
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The Export folder window opens.13 

 

6. Enter the file name. 

7. Click Save. 
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How to Print the MSP Claims Report 
1. Open Medicare Remit Easy Print by double-clicking the Medicare Remit Easy Print icon.

  
The Medicare Remit Easy Print Claim List tab opens. 

 
2. Click the down arrow on Report. 
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The Report List appears. 

 
3. Select MSP/Non-MSP Claims.  
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4. Select MSP Claims. 
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The Print and Export options appear. 

 
5. Select Print. 
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The Print denied line report window opens. 

6. Print the detail listing in one of the following ways: 

7. From the Print denied line report window, click Print to print the detail without previewing 
it. 

 
The Print dialog box opens. 

 
If you need to change the properties, click Properties and make changes as necessary. 

Click OK. Medicare Remit Easy Print prints the detail at your default printer. 

8. From the Print denied line report window, click Preview to view a preview of the printed 
page before printing. 
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The Print Preview window opens. 

 

Click Printer  at the top of the window. 

Medicare Remit Easy Print prints the detail at your default printer. 
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How to Export the MSP Claims Report 
You export the report in .csv (comma separated values) format. 

1. Open Medicare Remit Easy Print by double-clicking the Medicare Remit Easy Print icon. 
 

The Medicare Remit Easy Print Claim List tab opens.  

 
2. Click the down arrow on Report. 
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The Report List appears. 

 
3. Select MSP/Non-MSP Claims.  
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4. Select MSP Claims. 
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The Print and Export options appear. 

 
5. Select Export. 
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The Export folder window opens.13 

 

6. Enter the file name. 

7. Click Save. 
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How to Print the Non-MSP Claims Report 
1. Open Medicare Remit Easy Print by double-clicking the Medicare Remit Easy Print icon. 

  
The Medicare Remit Easy Print Claim List tab opens. 

 
2. Click the down arrow on Report. 
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The Report List appears. 

 
3. Select MSP/Non-MSP Claims.  
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4. Select Non-MSP Claims. 

The Print and Export options appear. 
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5. Select Print. 

The Print denied line report window opens. 

6. Print the detail listing in one of the following ways: 

7. From the Print denied line report window, click Print to print the detail without previewing 
it. 
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The Print dialog box opens. 

 
If you need to change the properties, click Properties and make changes as necessary. 

Click OK. Medicare Remit Easy Print prints the detail at your default printer. 

8. From the Print remit listing window, click Preview to view a preview of the printed page 
before printing. 

 
The Print Preview window opens. 

 

Click Printer  at the top of the window. 

Medicare Remit Easy Print prints the detail at your default printer. 
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How to Export the Non-MSP Claims Report 
You export the report in .csv (comma separated values) format. 

1. Open Medicare Remit Easy Print by double-clicking the Medicare Remit Easy Print icon. 

  
The Medicare Remit Easy Print Claim List tab opens.  

 
2. Click the down arrow on Report. 
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The Report List appears. 

 
3. Select MSP/Non-MSP Claims.  
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4. Select Non-MSP Claims. 
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The Print and Export options appear. 

 

 
5. Select Export. 



Medicare Remit Easy Print Working with Reports 

© 2016 Sponsored by the Centers for Medicare & Medicaid Services (CMS)  
under contract HHSM-500-2007-00021I/HHSM-500-T0008 – VMS Maintenance.  This document contains confidential and 

 proprietary information, which shall not be used, disclosed, or reproduced without the express written consent of CMS. 

192 

The Export folder window opens.13 

 

6. Enter the file name. 

7. Click Save. 
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How to Print the Other Adjustments Report 
1. Open Medicare Remit Easy Print by double-clicking the Medicare Remit Easy Print icon. 

  
The Medicare Remit Easy Print Claim List tab opens.  

 
2. Click the down arrow on Report. 
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The Report List appears. 

 
3. Select Other Adjustments. 
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The Print and Export options appear. 

 
4. Select Print. 

The Print denied line report window opens. 

5. Print the detail listing in one of the following ways: 

6. From the Print denied line report window, click Print to print the detail without previewing 
it. 
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The Print dialog opens. 

 
If you need to change the properties, click Properties and make changes as necessary. 

Click OK. Medicare Remit Easy Print prints the detail at your default printer. 

7. From the Print denied line report window, click Preview to view a preview of the printed 
page before printing. 

 
The Print Preview window opens. 

 

Click Printer  at the top of the window. 

Medicare Remit Easy Print prints the detail at your default printer. 



Medicare Remit Easy Print Working with Reports 

© 2016 Sponsored by the Centers for Medicare & Medicaid Services (CMS)  
under contract HHSM-500-2007-00021I/HHSM-500-T0008 – VMS Maintenance.  This document contains confidential and 

 proprietary information, which shall not be used, disclosed, or reproduced without the express written consent of CMS. 

197 

How to Export the Other Adjustments Report 
You export the report in .csv (comma separated values) format. 

1. Open Medicare Remit Easy Print by double-clicking the Medicare Remit Easy Print icon.

  
The Medicare Remit Easy Print Claim List tab opens.  

 
2. Click the down arrow on Report. 
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The Report List appears. 

 
3. Select Other Adjustments. 
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The Print and Export options appear. 

 
4. Select Export Report. 
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The Export folder window opens.13 

 
5. Enter the file name. 

6. Click Save. 
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How to Print the Entire Remittance Report 
1. Open Medicare Remit Easy Print by double-clicking the Medicare Remit Easy Print icon.

  
The Medicare Remit Easy Print Claim List tab opens.  

 
2. Click the down arrow on Report. 



Medicare Remit Easy Print Working with Reports 

© 2016 Sponsored by the Centers for Medicare & Medicaid Services (CMS)  
under contract HHSM-500-2007-00021I/HHSM-500-T0008 – VMS Maintenance.  This document contains confidential and 

 proprietary information, which shall not be used, disclosed, or reproduced without the express written consent of CMS. 

202 

The Report List appears. 

 
3. Select Entire Remittance. 

The Print remit listing window appears. 

4. Print the detail listing in one of the following ways: 

5. From the Print remit listing window, click Print to print the detail without previewing it. 
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The Print dialog box opens. 

 
If you need to change the properties, click Properties and make changes as necessary. 

Click OK. Medicare Remit Easy Print prints the detail at your default printer. 

6. From the Print Remit listing window, click Preview to view a preview of the printed page 
before printing. 

 
The Print Preview window opens. 

 

Click Printer  at the top of the window. 

Medicare Remit Easy Print prints the detail at your default printer. 
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Housekeeping for the Import Files 
Housekeeping includes: 

• Archiving files 

• Restoring files 

• Deleting files 

Archiving Import Files 
Medicare Remit Easy Print does NOT automatically archive any Import file, and Import files 
can slow down the processing time of the PC. 

Therefore, Medicare Remit Easy Print lets you archive Import files. The location you choose 
for the archive must have adequate security to protect PHI. 

How to Archive Import files 
1. Open Medicare Remit Easy Print by double-clicking the Medicare Remit Easy Print icon. 
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The Medicare Remit Easy Print Claim List tab opens. 

 
2. On the top of the window, select the file that you want to archive and click Archive. 
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The Archive Imported Files window opens.14 

 
3. Select the file(s) you want to archive by checking the box or boxes. 15 

This activates Archive. 

4. Click Archive. 

Medicare Remit Easy Print moves the file to the Archive folder. 

                                                 
14 Hint: 
You can use Browse to specify another location for the archived file. 
15 Hint: 
When you need to archive all the payers in the list, you can place a checkmark in the Check All box to archive all the claim 
files.  
When you check that option a checkmark is placed in front of all claims in the list. 
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Restoring Import files 
You can restore an Import file after you have archived it. 

For information about archiving Import files, see Archiving Import Files. 

How to Restore Import files 
1. Open Medicare Remit Easy Print by double-clicking the Medicare Remit Easy Print icon  

 . 

The Medicare Remit Easy Print Claim List tab opens. 

 
2. On the top of the window, click Restore. 
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The Restore Imported Files window opens. 

 
3. Select the file(s) you want to restore by checking the box or boxes. 15 

This activates Restore. 

4. Click Restore. 

Medicare Remit Easy Print moves the file from the Archive folder to the Import folder.  

The file is now available for viewing on your C drive at C:\Program Files\Medicare Remit 
EasyPrint\Import. 

 

Deleting Import files 
If you delete an Import file by mistake, you must re-import the HIPAA 835 file. You cannot 
restore the Import file. 

How to Delete an Import file 
1. Open Medicare Remit Easy Print by double-clicking the Medicare Remit Easy Print icon. 

  
The Medicare Remit Easy Print Claim List tab opens. 
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2. On the top of the window, click Delete. 
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The Delete selected import file(s) window opens. 

 
3. Select the file(s) you want to delete by checking the box(es). 16 

This activates Delete. 
4. Click Delete. 

Medicare Remit Easy Print deletes the file(s). 

                                                 
16 Hint: 
To delete all the claim files on the list, place a checkmark in the Check All box. When you check that box checkmark is 
placed in front of all the claims in the list. 
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Using Keystroke Shortcuts 
You can use a series of keystrokes to complete a number of tasks. 

To Do This… Use This 
Combination… 

Import a HIPAA 835 file Alt + F + I 

View a list of claims Alt + V + L 

View claim detail Alt + V + D 

View totals Alt + V + S 

View the way the data is stored in the file Alt + V + V 

Search the Remittance Advice Alt + V + E or 
Alt + S + S 

View the CARC and RARC codes for the Remittance Advice Alt + V + G 

Look up the meaning of a CARC/RARC code Alt + T + C 

Print the Adjusted Service Lines Report Alt + R + A + P 

Export the Adjusted Service Lines Report Alt + R + A + E 

Print the COB Claims Report Alt + R + B + C + 
P 

Export the COB Claims Report Alt + R + B + C + 
E 

Print the Non-COB Claims Report Alt + R + B + N + 
P 

Export the Non-COB Claims Report Alt + R + B + N + 
E 

Print the Deductible Service Lines Report Alt + R + E + D + 
P 

Export the Deductible Service Lines Report Alt + R + E + D + 
E 

Print the Coinsurance Service Lines Report Alt + R + E + C + 
P 

Export the Coinsurance Service Lines Report Alt + R + E + C + 
E 

Print the Deductible/Coinsurance Service Lines Report Alt + R + E + E + 
P 

Export the Deductible/Coinsurance Service Lines Report Alt + R + E + E + 
E 

Print the Denied Service Lines Report Alt + R + D + P 

Export the Denied Service Lines Report Alt + R + D + E 

Print the MSP Claims Report Alt + R + M + M + 
P 
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To Do This… Use This 
Combination… 

Export the MSP Claims Report Alt + R + M + M + 
E 

Print the Non-MSP Claims Report Alt + R + M + N + 
P 

Export the Non-MSP Claims Report Alt + R + M + N + 
E 

Print the Other Adjustments Report Alt + R + O + P 

Export the Other Adjustments Report Alt + R + O + E 

Print the Entire Remittance Report Alt + R + R 

Print the Remit List Alt + R + P 

Archive Import files Alt + T + A 

Restore archived Import files Alt + T + R 

Delete Import files Alt + T + D 

With the Claim List Tab Selected: No data 

Print Claim List Alt + B + P 

Check all claims in the list Alt + B + C 

Uncheck all claims in the list Alt + B + U 

With the Claim Detail Tab Selected: No data 

Print Claim Detail Alt + B + P 

Zoom In  Alt + B + I 

Zoom Out Alt + B + O 

Reset Zoom Alt + B + R 

Show Glossary ( check box ) Alt + B + S 

With the Remit Summary Tab Selected: No data 

Print Summary Alt + B + P 

Zoom In  Alt + B + I 

Zoom Out Alt + B + O 

Reset Zoom Alt + B + R 

With the Search Tab Selected: 17 No data 

Print Results Alt + B + P 

Claim Detail Results Alt + B + C 

                                                 
17 After executing a search 
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To Do This… Use This 
Combination… 

With the Glossary Tab Selected: No data 

Zoom In Alt + B + I 

Zoom Out Alt + B + O 

Reset Zoom Alt + B + R 

Codes Alt + B + C 
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Appendix A: MREP RA/HIPAA 835v5010 Segment Field 
Crosswalk 
This information can help you if you need to troubleshoot the Import file. 

Note:  This appendix represents the fields of an 835v5010 electronic remittance advice. However, MREP can 
also print or display remittances in the 4010A1format. Fields marked with an asterisk (*) below are not 
found on the 4010A1 format and do not appear when printed or shown. 

Remittance Advice Field 835 Loop ID 835 Segment Field Identification/Comments 

Payer (Contractor) Name 1000A N102  N101 = ‘PR’ 

Payer (Contractor) Address 1000A N301 N101 = ‘PR’, ADDR1 

   N302 N101 = ‘PR’, ADDR2 

Payer (Contractor) City 1000A N401 N101 = ‘PR’ 

Payer (Contractor) State 1000A N402 N101 = ‘PR’ 

Payer (Contractor) ZIP 1000A N403 N101 = ‘PR’ 

* PAYER’S WEB SITE:  1000A PER04 PER01 = ‘IC’ 

* PAYER BUSINESS 
CONTACT INFORMATION: 

1000A  PER01= ‘CX’ 

* Name  PER02  

* Email Address (up to 50 
positions) 

 PER04 or PER06 PER03 or PER05 = ‘EM’ 
(respectively) 

* Telephone Number 
 

 PER04 and PER06 
PER06 and PER08 

PER03 = ‘TE’ and PER05 = ‘EX’ 
PER05 = ‘TE’ and PER07 = ‘EX’ 

* PAYER TECHNICAL 
CONTACT INFORMATION: 

1000A  PER01= ‘BL’ 

Payee (Provider) Name 1000B N102 N101 = ‘PE’ 

Payee (Provider) Address 1000B N301 
 
N302 

N101 = ‘PE’, ADDR1 
 
N101 = ‘PE’, ADDR2 

Payee (Provider) City 1000B N401 N101 = ‘PE’ 

Payee (Provider) State 1000B N402 N101 = ‘PE’ 

Payee (Provider) ZIP 1000B N403 N101 = ‘PE’ 

PROVIDER #  
or  
NPI # 

1000B N104 
or 
REF02 

N101 = ‘PE’ & N103 = ‘XX’ 
 
Payee level REF01 = ‘1C’ 

Date  BPR16  

CHECK/EFT #  TRN02 BPR04 = ‘CHK’ or ‘EFT’ or ‘NON’ 

Assigned claims   LX01 = ‘1’, pertains only to 
Medicare 

NAME 
(Patient Last Name) 

2100 NM103 NM101 = ‘QC’ 

NAME 
(Patient First Name) 

2100 NM104 NM101 = ‘QC’ / NM102 = ‘1’ 



Medicare Remit Easy Print Appendix A: MREP RA/HIPAA 835v5010 Segment Field Crosswalk 

© 2016 Sponsored by the Centers for Medicare & Medicaid Services (CMS)  
under contract HHSM-500-2007-00021I/HHSM-500-T0008 – VMS Maintenance.  This document contains confidential and 

 proprietary information, which shall not be used, disclosed, or reproduced without the express written consent of CMS. 

215 

Remittance Advice Field 835 Loop ID 835 Segment Field Identification/Comments 

NAME 
(Patient Middle Name) 

2100 NM105 NM101 = ‘QC’ / NM102 = ‘1’ 

HIC  
(Patient ID) 

2100 NM109 NM108 = ‘HN’ 

ACNT  
(Patient Account Number) 

2100 CLP01  

ICN 
(Claim Control Number) 

 CLP07  

ASG  
(Claim Assignment) 

2000  Hard-coded ‘Y’ for Medicare when 
LX01 = ‘1’ 

MOA 
(Claim Level Remark Codes) 

2100 MOA03, MOA04, 
MOA05, MOA06, 
MOA07 

 

REND PROV  
(Rendering Provider) 

2110 REF02  REF01 = HPI or  
REF01 = ‘1C’  

 2100 NM109 or 
REF02  

NM108 = ‘XX’ or 
REF01 = ‘1C’  

 1000B N104 or  
REF02 or 
spaces 

N103 = ‘XX’ or 
REF01 = ‘XX’ 

SERV-DATE 
(From Service Date) 

2110 DTM02 Line level DTM01 = ‘150’ or ‘472’ 
else Claim level DTM01 = ‘232’ 

SERV-DATE 
(To Service Date) 

2110 DTM02 Line level DTM01 = ‘151’ or ‘472’ 
else Claim level DTM01 = ‘233’ 

POS 
(Place of Service) 

2110 REF02 REF01 = ‘LU’ 

PD-NOS 
(Paid Number of Services) 

2110 SVC05  

PD-PROC 
(Procedure code – paid and if 
down-coded then the original 
procedure appears under 
SUB-PROC.) 

2110 SVC01-2 SVC01-1 = ‘HC’ or ‘N4’ 

MODS 
(Procedure Code Modifiers)  

2110 SVC01-3, SVC01-4, 
SVC01-5, SVC01-6 

SVC01-1 = ‘HC’ or ‘N4’ 

BILLED 
(Billed Amount) 

2110 SVC02  

ALLOWED 
(Allowed Amount) 

2110 AMT02 AMT01 = ‘B6’ 

DEDUCT 
(Deductible Amount)  

2110 CAS03 or CAS06 or 
CAS09 or CAS12 or 
CAS15 or CAS18 

CAS01 = ‘PR’ & (CAS02 = ‘1’ or 
CAS05 = ‘1’ or CAS08 = ‘1’ or 
CAS11 = ‘1’ or CAS14 = ‘1’ or 
CAS17 = ‘1’) 

COINS 
(Coinsurance Amount) 

2110 CAS03 or CAS06 or 
CAS09 or CAS12 or 
CAS15 or CAS18 

CAS01 = ‘PR’ & (CAS02 = ‘2’ or 
CAS05 = ‘2’ or CAS08 = ‘2’ or 
CAS11 = ‘2’ or CAS14 = ‘2’ or 
CAS17 = ‘2’) 
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Remittance Advice Field 835 Loop ID 835 Segment Field Identification/Comments 

GRP/CARC 
(Group/Claim Adjustment 
Reason Code) 

 

2110 CAS01-CAS02, CAS05, 
CAS08, CAS11, CAS14, 
CAS17 

Do not print CAS01 = ‘PR’ and 
((CAS02 = ‘1’ or ‘2’) or (CAS05 = 
‘1’ or ‘2’) or (CAS08 ‘1’ or ‘2’) or 
(CAS11 = ‘1’ or ‘2’) or (CAS14 = ‘1’ 
or ‘2’) or (CAS17 ‘1’ or ‘2’)); hard-
code dash between group code 
and reason code 

CARC-AMT 
(Claim Adjustment Reason 
Code Amount) 
 

2110 CAS03 or CAS06 or 
CAS09 or CAS12 or 
CAS15 or CAS18 

Do not print CAS01 = ‘PR’ and 
((CAS02 = ‘1’ or ‘2’) or (CAS05 = 
‘1’ or ‘2’) or (CAS08 ‘1’ or ‘2’) or 
(CAS11 = ‘1’ or ‘2’) or (CAS14 = ‘1’ 
or ‘2’) or (CAS17 ‘1’ or ‘2’)) 

ADJ-QTY   
(Adjustment Quantity) 

2110 CAS04 or CAS07 or 
CAS10 or CAS13 or 
CAS16 or CAS19 

Do not print CAS01 = ‘PR’ and 
((CAS02 = ‘1’ or ‘2’) or (CAS05 = 
‘1’ or ‘2’) or (CAS08 ‘1’ or ‘2’) or 
(CAS11 = ‘1’ or ‘2’) or (CAS14 = ‘1’ 
or ‘2’) or (CAS17 ‘1’ or ‘2’)) 

BS 
(CAQH CORE-defined  
Business Scenario) 

  Based on the CARC 

PROV-PD 
(Provider Paid Amount) 

2110 SVC03  

SUB-NOS : 
(Submitted Number of 
Services) 

2110 SVC07 If paid units of service (SVC05) do 
not equal submitted units of 
service 

SUB-PROC 
(Submitted Procedure Code) 

2110 SVC06-2, SVC06-3, 
SVC06-4, SVC06-5, 
SVC06-6 

 

RARC 
(Line Level Remark Codes) 

2110 LQ02 LQ01 = ‘HE’ 

* CNTL #: 
(Line Item Control Number) 
 

2110 REF02 REF01 = ‘6R’ 

* HCPI: 
(HealthCare Policy 
Information) 
 

2110 REF02 REF01 = ‘0K’ (zero K) 

PT RESP 
(Patient Responsibility) 

2100 CLP05  

CARC 
(Total of all Claim Adjustment 
Reason Code amounts) 

  Sum of all lines CAS monetary 
amounts, except those associated 
with adjustment reason codes ‘1’ 
and ‘2’ (Group code PR) 

CLAIM TOTALS 
(Billed Amount) 

2100 CLP03  

CLAIM TOTALS 
(Allowed Amount) 

  Sum of all lines AMT02, when 
AMT01 = ‘B6’ 

CLAIM TOTALS 
(Deductible Amount) 

  Sum of all lines CAS monetary 
amounts, when CAS01 = ‘PR’ and 
the corresponding adjustment 
reason code equals ‘1’ 

CLAIM TOTALS 
(Coinsurance Amount) 

  Sum of all lines CAS monetary 
amounts, when CAS01 = ‘PR’ and 
the corresponding adjustment 
reason code equals ‘2’ 
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Remittance Advice Field 835 Loop ID 835 Segment Field Identification/Comments 

CLAIM TOTALS 
(Provider Paid Amount) 

2100 CLP04  

ADJ TO TOTALS: PREV PD 
(Adjustment to Totals: 
Previous Paid Amount) 

  Not avalable 

ADJ TO TOTALS: INTEREST 
(Adjustment to Totals: Interest 
Amount) 

2100 AMT02 Claim level AMT01 = ‘I’ 

ADJ TO TOTALS: LATE 
FILING CHARGE 
(Adjustment to Totals: Late 
Filing Charge) 
 

2110  Sum of all line level AMT02, when 
AMT01 = ‘KH’ 

NET   Sum of all the line level provider 
paid amts plus adj to totals: 
interest minus adj to totals: late 
filing charge 

GRP/CARC 
(Group Code/Claim 
Adjustment Reason Code) 

2100 CAS01–CAS02, CAS05, 
CAS08, CAS11, CAS14, 
CAS17 

Do not print CAS01–CAS02, 
CAS05, CAS08, CAS11, CAS14, 
CAS17 

CARC-AMT 
(Claim Adjustment Reason 
Code Amount) 

2100 CAS03 or CAS06 or 
CAS09 or CAS12 or 
CAS15 or CAS18 

Do not print CAS03 or CAS06 or 
CAS09 or CAS12 or CAS15 or 
CAS18 

BS 
(CAQH CORE-defined  
Business Scenario) 

  Based on the CARC 

CLAIM INFORMATION 
FORWARDED TO: 

2100  NM101 = ‘TT’  
 

(Crossover Carrier Name)  NM103  NM102 = ‘2’ 

* (Crossover Carrier Identifier)  NM109 NM108 = ‘PI’ or ‘XV’ 

* CORRECTED PRIORITY 
PAYER INFO: 

2100  NM101 = ‘PR’ 

* (Corrected Priority Payer 
Name) 

 NM103  NM102 = ‘2’ 

* (Corrected Priority Payer 
Identification Number) 

 NM109 NM108 = ‘PI’ or ‘XV’ 

TOTALS: # OF CLAIMS   Number of CLP segments within a 
LX 

TOTALS: BILLED AMT 
(Total – Billed Amount) 

  Sum of CLP03 

TOTALS: ALLOWED AMT 
(Total – Allowed Amount) 

  Sum of AMT02 when AMT01 = 
‘B6’ 

TOTALS: DEDUCT AMT 
(Total – Deductible Amount) 

  Sum of CAS monetary amts, when 
CAS01 = ‘PR’ and the 
corresponding adjustment reason 
code equals ‘1’ 

TOTALS: COINS AMT 
(Total – Coinsurance Amount) 

  Sum of CAS monetary amts, when 
CAS01 = ‘PR’ and the 
corresponding adjustment reason 
code equals ‘2’ 
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TOTAL: CARC-AMT 
(Total – Claim Adjustment 
Reason Code Amount) 

  Sum of CAS monetary amounts, 
excepting those associated with 
adjustment reason codes ‘1’ and 
‘2’ 

TOTALS: PROV-PD AMT 
(Total – Provider Paid 
Amount) 

  Sum of CLP04 

TOTALS: PROV ADJ AMT 
(Total – Provider Adjustment 
Amount) 

  Sum of AMT02 when AMT01 = 
‘B6’ and ‘KH’ 
(The sum of the details (amount) in 
the PROVIDER ADJ DETAILS 
section.)  

CHECK AMT 

(Check Amount) 

 BPR02  

Provider Adjustment Details    

PLB REASON CODE  PLB03-1, PLB05-1,  
PLB07-1, PLB09-1, 
PLB11-1, PLB13-1 

 

FCN/OTHER IDENTIFIER  Positions 1–50 of 
PLB03-2, PLB05-2, 
PLB07-2, PLB09-2, 
PLB11-2, PLB13-2 

 

AMOUNT  PLB04, PLB06, PLB08, 
PLB10, PLB12, PLB14 

 

Summary of non-assigned 
claims 

  LX01 = ‘0’, pertains only to 
Medicare 

NAME 
(Patient Last Name) 

2100 NM103 NM101 = ‘QC’ 

NAME 
(Patient First Name) 

2100 NM104 NM101 = ‘QC’ / NM102 = ‘1’ 

NAME 
(Patient Middle Name) 

2100 NM105 NM101 = ‘QC’ / NM102 = ‘1’ 

HIC 
(Patient ID) 

2100 NM109 NM108 = ‘HN’ 

ACNT  
(Patient Account Number) 

2100 CLP01  

ICN 
(Claim Control Number) 

 CLP07  

ASG  
(Claim Assignment) 

2000  Hard-coded ‘N’ for Medicare when 
LX01 = ‘0’ 

MOA 
(Claim Level Remark Codes) 

2100 MOA03, MOA04, 
MOA05, MOA06, 
MOA07 

 



Medicare Remit Easy Print Appendix A: MREP RA/HIPAA 835v5010 Segment Field Crosswalk 

© 2016 Sponsored by the Centers for Medicare & Medicaid Services (CMS)  
under contract HHSM-500-2007-00021I/HHSM-500-T0008 – VMS Maintenance.  This document contains confidential and 

 proprietary information, which shall not be used, disclosed, or reproduced without the express written consent of CMS. 

219 

Remittance Advice Field 835 Loop ID 835 Segment Field Identification/Comments 

REND PROV 
(Rendering Provider) 

2110 REF02 REF01 = HPI or  
REF01 = ‘1C’ 

 2100 NM109 or 
REF02  

NM108 = ‘XX’ or 
REF01 = ‘1C’  

 1000B N104 or  
REF02 or 
spaces 

N103 = ‘XX’ or 
REF01 = ‘XX’ 

SERV-DATE 
(From Service Date) 

2110 DTM02 Line level DTM01 = ‘150’ or ‘472’ 
else Claim level DTM01 = ‘232’ 

SERV-DATE 
(To Service Date) 

2110 DTM02 Line level DTM01 = ‘151’ or ‘472’ 
else Claim level DTM01 = ‘233’ 

POS 
(Place of Service) 

2110 REF02 REF01 = ‘LU’ 

PD-NOS 
(Paid Number of Services) 

2110 SVC05  

PD-PROC 
(Procedure code – paid and if 
down-coded then the original 
procedure appears.) 

2110 SVC01-2 SVC01-1 = ‘HC’ or ‘N4’ 

MODS 
(Procedure code modifiers) 

2110 SVC01-3, SVC01-4, 
SVC01-5, SVC01-6 

SVC01-1 = ‘HC’ or ‘N4’ 

BILLED 
(Billed Amount) 

2110 SVC02  

ALLOWED 
(Allowed Amount) 

2110 AMT02 AMT01 = ‘B6’ 

DEDUCT 
(Deductible Amount) 

2110 CAS03 or CAS06 or 
CAS09 or CAS12 or 
CAS15 or CAS18 

CAS01 = ‘PR’ & (CAS02 = ‘1’ or 
CAS05 = ‘1’ or CAS08 = ‘1’ or 
CAS11 = ‘1’ or CAS14 = ‘1’ or 
CAS17 = ‘1’) 

COINS 
(Coinsurance Amount) 

2110 CAS03 or CAS06 or 
CAS09 or CAS12 or 
CAS15 or CAS18 

CAS01 = ‘PR’ & (CAS02 = ‘2’ or 
CAS05 = ‘2’ or CAS08 = ‘2’ or 
CAS11 = ‘2’ or CAS14 = ‘2’ or 
CAS17 = ‘2’) 

GRP/CARC 
(Group Code/ Claim 
Adjustment Reason Code) 

2110 CAS01-CAS02, CAS05, 
CAS08, CAS11, CAS14, 
CAS17 

Do not print CAS01 = ‘PR’ and 
((CAS02 = ‘1’ or ‘2’) or (CAS05 = 
‘1’ or ‘2’) or (CAS08 ‘1’ or ‘2’) or 
(CAS11 = ‘1’ or ‘2’) or (CAS14 = ‘1’ 
or ‘2’) or (CAS17 ‘1’ or ‘2’)); hard-
code dash between group code 
and reason code 

CARC-AMT 
(Claim Adjustment Reason 
Code Amount) 

2110 CAS03 or CAS06 or 
CAS09 or CAS12 or 
CAS15 or CAS18 

Do not print CAS01 = ‘PR’ and 
((CAS02 = ‘1’ or ‘2’) or (CAS05 = 
‘1’ or ‘2’) or (CAS08 ‘1’ or ‘2’) or 
(CAS11 = ‘1’ or ‘2’) or (CAS14 = ‘1’ 
or ‘2’) or (CAS17 ‘1’ or ‘2’)) 

ADJ-QTY 
(Adjusted Quantity) 

2110 CAS04 or CAS07 or 
CAS10 or CAS13 or 
CAS16 or CAS19 

Do not print CAS01 = ‘PR’ and 
((CAS02 = ‘1’ or ‘2’) or (CAS05 = 
‘1’ or ‘2’) or (CAS08 ‘1’ or ‘2’) or 
(CAS11 = ‘1’ or ‘2’) or (CAS14 = ‘1’ 
or ‘2’) or (CAS17 ‘1’ or ‘2’) 

BS 
(CAQH CORE-defined 
Business Scenario) 

  Based on the CARC 
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PROV-PD 
(Provider Paid Amount) 

2110 SVC03  

SUB-NOS  
(Submitted Number of 
Services) 

2110 SVC07 If paid units of service (SVC05) do 
not equal submitted units of 
service 

SUB-PROC 
(Submitted procedure code) 

2110 SVC06-2, SVC06-3, 
SVC06-4, SVC06-5, 
SVC06-6 

 

RARC 
(Line Level Remark Codes) 

2110 LQ02 LQ01 = ‘HE’ 

PT RESP 
(Patient Responsibility) 

2100 CLP05  

CARC 
(Total of all Claim Adjustment 
Reason Code amounts) 

  Sum of all lines CAS monetary 
amounts, except those associated 
with adjustment reason codes ‘1’ 
and ‘2’ (Group code PR) 

CLAIM TOTAL 
(Billed Amount) 

2100 CLP03  

CLAIM TOTAL 
(Allowed Amount) 

  Sum of all lines AMT02, when 
AMT01 = B6. 

CLAIM TOTAL 
(Deductible Amount) 

  Sum of all lines CAS monetary 
amounts, when CAS01 = ‘PR’ and 
the corresponding adjustment 
reason code equals ‘1’ 

CLAIM TOTAL 
(Coinsurance Amount) 

  Sum of all lines CAS monetary 
amounts, when CAS01 = ‘PR’ and 
the corresponding adjustment 
reason code equals ‘2’ 

CLAIM TOTAL 
(Provider Paid Amount) 

2100 CLP04 No data 

ADJ TO TOTALS: PREV PD 
(Adjustment to Totals: 
Previous Paid Amount) 
 

  Not available 

ADJ TO TOTALS: INTEREST 
(Adjustment to Totals: Interest 
Amount) 

2100 AMT02 Claim level AMT01 = ‘I’ 

ADJ TO TOTALS: LATE 
FILING CHARGE 
(Adjustment to Totals: Late 
Filing Charge) 

2110  Sum of all line level AMT02, when 
AMT01 = ‘KH’ 

NET No data No data Sum of all the line level provider 
paid amts plus adj to totals: 
interest minus adj to totals: late 
filing charge 

GRP/CARC 
(Group Code/Claim 
Adjustment Reason Code) 

2100 CAS01-CAS02, CAS05, 
CAS08, CAS11, CAS14, 
CAS17 

Do not print CAS01-CAS02, 
CAS05, CAS08, CAS11, CAS14, 
CAS17 

CARC-AMT 
(Claim Adjustment Reason 
Code Amount) 

2100 CAS03 or CAS06 or 
CAS09 or CAS12 or 
CAS15 or CAS18 

Do not print CAS03 or CAS06 or 
CAS09 or CAS12 or CAS15 or 
CAS18 
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BS 
(CAQH CORE Code-defined 
Business Scenario) 

No data No data Based on the CARC 

CLAIM INFORMATION 
FORWARDED TO: 
 

2100 No data NM101 = ‘TT’  

* (Crossover Carrier Name) 
 

No data NM103  NM102 = ‘2’ 

* (Crossover Carrier Identifier) 
 

No data NM109 NM108 = ‘PI’ or ‘XV’ 

* CORRECTED PRIORITY 
PAYER INFO : 
 

2100 No data NM101 = ‘PR’ 

* (Corrected Priority Payer 
Name) 
 

No data NM103  NM102 = ‘2’ 

* (Corrected Priority Payer 
Identification Number) 
 

No data NM109 NM108 = ‘PI’ or ‘XV’ 

* OTHER CLAIM REL 
IDENTIFICATION  
 

2100 REF02 when 
REF01=’1L’, ‘1W’, ’28’,  
‘6P’, ‘9A’, ‘9C’,  
‘BB’, ‘CE’, ‘EA’, ‘F8’, 
‘G1’, ‘G3’, ‘IG’ OR ‘SY’ 

No data 

GLOSSARY No data MOA03, MOA04, 
MOA05, MOA06, 
MOA07, CAS01, 
CAS02, CAS05, CAS08, 
CAS11, CAS14, CAS17, 
BS 

If there are duplicates, only print 
once 
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Appendix B:  Abbreviation and Acronym Glossary  
 
The following two column table provides the abbreviations or acronym values in the first 
column, and the second column contains the descriptions. 
 

Abbreviation or Acronym 
Value 

Description 

ACNT Account 
ADJ Adjustment 
ADJ-QTY Adjustment Quantity 
Adjst Adjustment 
AMT Amount 
ASG Assignment of claim 
Bene Beneficiary 
BS CAQH CORE-defined Business Scenario 
CARC Claim Adjustment Reason Code 
CARC-AMT Claim Adjustment Reason Code Amount 
CNTL# Control Number 
COB Coordination of Benefits 
COIN Coinsurance 
Coins Coinsurance 
Deduct Deductible 
DMERC Durable Medical Equipment Resource Center 
ERA Electronic Remittance Advice 
EFT Electronic Funds Transfer 
GRP/CARC Group and Claim Adjustment Reason Codes 
HCPCS Health Care Procedure Codes 
HCPI Health Care Policy Information 
HIC Health Insurance Claim Number 
HICN  Health Insurance Claim Number 
HIPAA Health Insurance Portability and Accountability Act 
ID Identifier 
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Abbreviation or Acronym 
Value 

Description 

ICN Internal Control Number 
MOA Medicare Outpatient Adjudication 
MODS Modifiers 
MREP Medicare Remit Easy Print 
MSP Medicare Secondary Payer 
NDC National Drug Code 
NPI National Provider Identifier 
NOS Number of Services 
Orig Original 
PD-NOS Number of Services – Paid  
PD-PROC Procedure Code – Paid 
PHI Personal Health Information 
PLB Provider Level Balancing 
POS Place of Service 
PREV PD Previous Paid 
PROC Procedure Code  
PROV Provider 
PROV-PD Provider Paid 
PT RESP Patient Responsibility 
RARC Remittance Advice Remark Code 
Remit Remittance Advice 
REND-PROV Rendering Provider 
SERV-DATE Service Dates 
SPR Standard Paper Remittance advice 
SUB-NOS Submitted Number of Services 
SUB-PROC Submitted HCPCS Procedure Code 
ZIP ZIP Code 
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